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IMPORTANT! Before using this product, read and understand the information in the “Safety” appendix
in this document.

Product description

Kit overview

The VeriFiler" Express PCR Amplification Kit is a 6-dye, short tandem repeat (STR) multiplex assay for
the amplification of single-source human genomic DNA.

The kit is part of a fully integrated and validated forensic DNA workflow backed by best-in-class global
training, service, and support. This kit is optimized for paternity and single-source samples.
The kit amplifies the following loci within the read region of 75-465 nt:

e 23 autosomal STR loci (D3S1358, VWA, D16S539, CSF1PO, TPOX, D8S1179, D21S11, D18S51,
D2S441, D19S433, THO1, FGA, D22S1045, D5S818, D13S317, D7S820, D10S1248, D1S1656,
D12S391, D2S1338, D6S1043, Penta D, Penta E)

* 1 insertion/deletion polymorphic marker on the Y chromosome (Y indel)

* Amelogenin (sex-determining marker)
The VeriFiler" Express kit delivers a 25-locus multiplex with the highest discrimination power of

any Thermo Fisher Scientific Human Identification Kit. The highly optimized buffer formulation allows
completion of amplification in ~45 minutes.

The VeriFiler" Express kit uses the same improved process for synthesis and purification of the
amplification primers developed for other next-generation Thermo Fisher Scientific STR chemistries.
The improved amplification primers deliver clean electrophoretic backgrounds that assist interpretation.
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Single-source sample types supported

The VeriFiler" Express kit is optimized to allow direct amplification from the following types of single-
source samples without the need for sample purification:

¢ Blood and buccal samples on treated paper substrates.

e Blood and buccal samples collected on untreated paper substrates and treated with Prep-n-Go™
Buffer.

* Buccal samples collected on swab substrates and treated with Prep-n-Go™ Buffer.

Substrate examples

* Treated paper: COPAN NUCLEIC-CARD™ system or Whatman FTA™ cards
¢ Untreated paper: Bode Buccal DNA Collector™ or 903 paper
e Swab: COPAN 4N6FLOQSwabs™ reference collection devices or cotton swabs

Note: Our testing does not include blood samples on swab substrates. This sample type is not
typically used for the collection of reference samples.

About the primers

The VeriFiler" Express kit primers are manufactured using the same synthesis and purification
improvements as the primers in the NGM SElect™, the Sinofiler”, and the Identifiler” Plus kits. These
improvements enhance the assay signal-to-noise ratio and simplify the interpretation of results.

The VeriFiler" Express kit includes the same primers as the GlobalFiler™ Express PCR Amplification Kit
with the following primer additions and modifications:

* Addition of new primers for Penta D, Penta E, and D6S1043.

¢ Addition of 1 new SNP-specific primer for D19S433 loci to address a SNP in the primer binding
site.

Non-nucleotide linkers are used in primer synthesis for the following loci: D19S433, vWA, CSF1PO,
D2S441, THO1, FGA, and D12S391. For these primers, non-nucleotide linkers are placed between the
primers and the fluorescent dye during oligonucleotide synthesis (Butler 2005, Grossman et al., 1994).
Non-nucleotide linkers enable reproducible positioning of the alleles to facilitate interlocus spacing. The
combination of a 6-dye fluorescent system and the use of non-nucleotide linkers allows simultaneous
amplification and efficient separation of all 25 markers during automated DNA fragment analysis.

Dyes used in the kit

Dye Color Label
6-FAM™ Blue Samples, allelic ladders, and controls
vic™ Green
NED™ Yellow
TAZ" Red

VeriFiler™ Express PCR Ampilification Kit User Guide 9
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(continued)
Dye Color Label
SIp™ Purple Samples, allelic ladders, and controls
Lz Orange GeneScan" 600 LIZ™ Size Standard v2.0

Loci amplified by the kit

Table 1 VeriFiler" Express kit loci and alleles

Locus | Ghromosome Alieles included in Allelic Ladder Dye label | DINAControl
designation location 007
D3S1358 3p21.31 9,10, 11,12,13, 14,15, 16, 17, 18, 19, 20 6-FAM™ 15,16
vWA 12p13.31 11,12, 13, 14, 15, 16, 17, 18, 19, 20, 21, 22, 23, 14,16
24
D16S539 16924.1 5,8,9,10,11, 12,13, 14, 15 9,10
CSF1PO 5033.3-34 6,7,8,9,10, 11,12, 13, 14, 15 11,12
TPOX 2p23-2per 5,6,7,8,9,10,11, 12,13, 14, 15 8,8
Y indel Yqg11.221 1,2 vic™ 2
Amelogenin X: p22.1-22.3 | X, Y X, Y
Y:p11.2
D8S1179 8024.13 5,6,7,8,910,11,12,13, 14,15, 16, 17, 18, 19 12,13
D21S11 21911.2-q21 |24, 24.2, 25, 26, 27, 28, 28.2, 29, 29.2, 30, 30.2, 28, 31
31, 31.2, 32, 32.2, 33, 33.2, 34, 34.2, 35, 35.2,
36, 37, 38
D18S51 18921.33 7,9,10,10.2, 11,12, 13, 13.2, 14, 14.2, 15, 16, 12,15
17,18, 19, 20, 21, 22, 23, 24, 25, 26, 27
Penta E 15026.2 5,6,7,8,9, 610,11, 12,13, 14, 15, 16, 17, 18, 7,12
19, 20, 21, 22, 23, 24, 25, 26
D2S441 2p14 8,9,610,11,11.3, 12, 13, 14, 15, 16, 17 NED™ 14,15
D19S433 19912 6,7,8,9,10, 11,12, 12.2, 13, 13.2, 14, 14.2, 15, 14,15
15.2, 16, 16.2, 17, 17.2, 18.2, 19.2
THO1 11p15.5 4,5,6,7,8,9,9.3,10, 11, 13.3 7,9.3
FGA 4928 13, 14,15, 16, 17, 18, 19, 20, 21, 22, 23, 24, 25, 24, 26
26, 26.2, 27, 28, 29, 30, 30.2, 31.2, 32.2, 33.2,
42.2,43.2,44.2,45.2,46.2, 47.2, 48.2, 50.2,
51.2
D22S51045 22q12.3 8,9, 610,11,12, 13, 14, 15,16, 17, 18, 19 TAZ" 11,16

10
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Table 1 VeriFiler Express kit loci and alleles (continued)

i

Locus Chromosome Alleles included in Allelic Ladder Byslabelt s centel
designation location 007
D55818 5q21-31  |7,8,9,10, 11,12, 13, 14, 15, 16, 17, 18 TAZ™ 11, 11
D13S317 13q22-31  |5,6,7,8,9,10, 11, 12, 13, 14, 15, 16 11, 11
D75820 7q11.21-22 |6,7,8,9, 10,11, 12, 13, 14, 15 7,12
D6S1043 69161 |9,10, 11,12, 13, 14, 15, 16, 17, 18, 19, 20, 21, 12, 14
22,23, 24, 25
D10S1248 109263 |8, 9,10, 11,12, 13, 14, 15, 16, 17, 18, 19 sip™ 12, 15
D1S1656 19422 19,10,11,12,13, 14, 14.3, 15, 15.3, 16, 16.3, 17, 13, 16
17.3,18.3,19.3, 20.3
D125391 12p132  |14,15,16,17, 18,19, 19.3, 20, 21, 22, 23, 24, 18, 19
25,26, 27
D251338 235 11,12, 13, 14, 15, 16, 17, 18, 19, 20, 21, 22, 23, 20, 23
24,25, 26, 27, 28
Penta D 21q22.3  |2.2,32,5,6,7,8,9,10, 11, 12, 13, 14, 15, 16, 11,12
17

Standards and controls that are required

For the VeriFiler™ Express kit, the panel of standards needed for PCR amplification, PCR product sizing,
and genotyping are:

* DNA Control 007 —A positive control for evaluating the efficiency of the amplification step and STR
genotyping using the VeriFiler™ Express Allelic Ladder. DNA Control 007 is present in the kit. See
“DNA Control 007 profile” on page 12.

e GeneScan™ 600 LIZ™ Size Standard v2.0—Used for obtaining sizing results. This standard, which
has been evaluated as an internal size standard, yields precise sizing results for PCR products.

Order the GeneScan ' 600 LIZ™ Size Standard v2.0 (Cat. No. 4408399) separately.

 VeriFiler" Express Allelic Ladder—Developed for accurate characterization of the alleles
amplified by the kit. The Allelic Ladder is present in the kit and allows automatic genotyping of
most of the reported alleles for the loci in the kit. See “Allelic ladder profile” on page 12.

VeriFiler™ Express PCR Ampilification Kit User Guide
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Allelic ladder profile
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Figure 1 GeneMapperm ID-X Software plot of the VeriFiler™ Express Allelic Ladder

DNA Control 007 profile
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Figure 2 DNA Control 007 (2 ng) amplified at 27 PCR cycles with the VeriFiler” Express kit and analyzed on an
Applied Biosystems™ 3500xL Genetic Analyzer (Y-axis scale 0 to 14,000 RFU).

12 VeriFiler™ Express PCR Ampilification Kit User Guide



Contents and storage

Chapter 1 Product information [

e
Contents and storage

Table 2 VeriFiler" Express PCR Ampilification Kit (Cat. No. A32014; 200 reactions)

Contents

Amount

Storage

VeriFiler™ Express Master Mix

Contains MgCl,, dATP, dGTP, dCTP, and dTTP, bovine serum
albumin, enzyme, and 0.05% sodium azide in buffer and salt.

2 tubes, 1.0 mL

—-25°C to -15°C on receipt.

2°C to 8°C after first use, for
up to 6 months or up to the
expiration date stated on the
kit (whichever comes first).

VeriFiler" Express Primer Set

Contains locus-specific 6-FAM™, VIC™, NED™, TAZ", and SID™
dye-labeled and unlabeled primers in buffer. The primers
amplify the STR loci D3S1358, VWA, D16S539, CSF1PO,TPOX,
D8S1179, D21S11, D18S51, Penta E, D2S441, D19S433,
THO1, FGA, D22S1045, D5S818, D13S317, D7S820, D6S1043,
D10S1248, D1S1656, D12S391, D251338, Penta D, and the
sex-determining markers, Y indel and Amelogenin.

2 tubes, 1.0 mL

—25°C to —15°C on receipt.

2°C to 8°C after first use, for
up to 6 months or up to the
expiration date stated on the
kit (whichever comes first).

Store protected from light.

VeriFiler™ Express PCR Ampilification Kit User Guide

13



gih‘- .ﬁnﬁ

Chapter 1 Product information
Contents and storage

Table 2 VeriFiler Express PCR Ampilification Kit (Cat. No. A32014; 200 reactions) (continued)

Contents

Amount

Storage

VeriFiler™ Express Allelic Ladder

Contains the following amplified alleles:

e 6-FAM" dye (blue): D3S1358 9-20; VWA 11-24; D16S539
5, 8-15; CSF1PO 6-15; TPOX 5-15.

e VIC" dye (green): Y indel 1, 2; Amelogenin X, Y; D8S1179
5-19; D21S11 24, 24.2, 25-28, 28.2, 29, 29.2, 30, 30.2, 31,
31.2, 32, 32.2, 33, 33.2, 34, 34.2, 35, 35.2, 36-38; D18S51
7,9,10,10.2, 11-13, 13.2, 14, 14.2, 15-27; DYS391 7-13;
Penta E 5-26.

e NED" dye (yellow): D2S441 8-11, 11.3, 12-17; D19S433
6-12,12.2,13,13.2, 14, 14.2, 15, 15.2, 16, 16.2, 17, 17.2,
18.2, 19.2; THO1 4-9, 9.3, 10, 11, 13.3; FGA 13-26, 26.2,
27-30, 30.2, 31.2, 32.2, 33.2, 42.2, 43.2, 44.2, 45.2, 46.2,
47.2,48.2,50.2, 51.2.

o TAZ" dye (red): D22S1045 8-19; D5S818 7-18; D13S317
5-16; D7S820 6-15; D6S1043 9-25.

e SID" dye (purple): D10S1248 8-19; D1S1656 9-14, 14.3,
15,15.3, 16, 16.3, 17, 17.3, 18.3, 19.3, 20.3; D12S391 14—
19, 19.3, 20-27; D2S1338 11-28; Penta D 2.2, 3.2, 5-17.

1 tube, 0.05 mL

—25°C to -15°C on receipt.

2°C to 8°C after first use, up
to the expiration date stated
on the kit.

Store protected from light.

IMPORTANT! The allelic
ladder contains PCR
products. Do not amplify.
To avoid contamination,
store the allelic ladder
separate from the other
kit components and
unamplified DNA.

DNA Control 007

Contains 2.0 ng/pL human male genomic DNA in 0.05% sodium
azide and buffer.

The profile of this male DNA is D3S1358 15,16; VWA 14,

16; D16S539 9, 10; CSF1PO 11,12; TPOX 8; D8S1179 12,

13; D21S11 28, 31; D18S51 12, 15; Penta E 7, 12; D2S441
14,15; D19S433 14,15; THO1 7, 9.3; FGA 24, 26; D22S1045 11,
16; D5S818 11; D13S317 11; D7S820 7,12; D6S1043 12, 14;
D10S1248 12, 15; D1S1656 13, 16; D12S391 18, 19; D2S1338
20, 23; Penta D 11, 12.

1 tube, 0.05 mL

—25°C to -15°C on receipt.

2°C to 8°C after first use, up
to the expiration date stated
on the kit.

14
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Required materials not supplied

Required materials not supplied

See Appendix B, “Required materials not supplied”.

Instrument and software compatibility

Catalog numbers that appear as links open the web pages for those products.

Instrument Validated models
type
Thermal * ProFlex” 96-well PCR System (Cat. No. 4484075)
cyclers  GeneAmp™ PCR System 9700, 96-Well Silver (Cat. No. N8050001)
* GeneAmp" PCR System 9700, 96-Well Gold-Plated (Cat. No. 4314878)
IMPORTANT! VeriFiler™ Express kit is NOT validated for use with:
. Veriti" 96-Well Thermal Cycler (Cat. No. 4479071)
. Veriti" Fast 96-Well Thermal Cycler (Cat. No. 4375305)
. GeneAmp™ PCR System 9700, 96-Well Aluminum (Cat. No. 4314879)
Genetic SeqStudio™ Genetic Analyzer
1 ™
analyzers!'! * SeqStudio™ Data Collection Software v1.2

* SeqStudio™ Data Collection Software v1.2.1

3500/3500xL Genetic Analyzer

* 3500 Series Data Collection Software 1 (Windows" Vista operating system) and HID Updater
3500 Data Collection Software v2 (Cat. No. 4480670)

* 3500 Series Data Collection Software 2 (Windows™ 7 operating system) and HID Updater
3500 Data Collection Software v2 (Cat. No. 4480670)

* 3500 Series Data Collection Software 3 (Windows™ 7 operating system)
* 3500 Series Data Collection Software 3.1 (Windows" 7 operating system)
* 3500 Series Data Collection Software 4 (Windows" 10 operating system)

* 3500 Series HID Data Collection Software v4.0.1 (Windows™ 10 operating system)

3130/3130x/ Genetic Analyzer
* 3130 Series Data Collection Software 4 (Windows™ 7 operating system)
* 3130/3730 Data Collection 4 6-Dye Module v1

VeriFiler™ Express PCR Ampilification Kit User Guide 15
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(continued)
Instrument .
Validated models
type
Genetic 3730/3730xI DNA Analyzer
1 ™
analyzers!' 3730 Series Data Collection Software 4 (Windows" 7 operating system)
® 3730 Series Data Collection Software 4 6-Dye Module v1
* 3730xI Data Collection Software 5 (Windows™ 10 operating system)
Note: For information on using the 3730xI DNA Analyzer, see the 3730x/ Data
Collection Software 5 for HID User Bulletin: New Features and Developmental Validation
(Pub. No. MANO019461).
Analysis GeneMapper " ID-X Software v1.4 or later
software . ™ . ™ . ™ .
Windows = XP, Windows = 7, or Windows = 10 operating system

[l We conducted validation studies using the SeqStudio™, 3130x/, 3500, 3500xL, and 3730x/ instruments. For validation information on the
SeqStudio™ instrument, see the SeqStudio™ Genetic Analyzer for HID Instrument and Software v1.2.1 User Bulletin—New Features and
Developmental Validation (Pub. No. 100086084). For validation information on the 3730x/ instrument, see the 3730x/ Data Collection Software 5
for HID User Bulletin: New Features and Developmental Validation (Pub. No. MANO019461).

16
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Workflow

Perform PCR on treated or untreated paper
substrates

“Prepare the reactions: treated paper substrate” on
page 21 or

“Prepare the reactions: untreated paper substrate” on

page 23
v

Obtain punch with Harris Manual Punch or BSD
Semi-Automated Dried Sample Punch Instrument

v

Untreated paper only: Process with Prep-n-Go™
Buffer

v
Process with VeriFiler™ Express kit

v

Chapter 1 Product information ~ [S¥
Workflow

Perform PCR on swab substrates

“Prepare the reactions: swab substrate” on page 26

Lyse in Prep-n-Go " Buffer

v
Process with VeriFiler" Express kit

v

Amplify with the GeneAmp™ PCR System 9700 or ProFlex™ 96-well PCR System
v

Perform electrophoresis
“Set up the SeqStudio™ instruments for electrophoresis (before first use of the kit)” on page 30 or
“Set up the 3500/3500xL instruments for electrophoresis (before first use of the kit)” on page 32 or
“Set up the 3130/3130xI instruments for electrophoresis (before first use of the kit)” on page 34 or

“Set up the 3730/3730xI instruments for electrophoresis (before first use of the kit)” on page 36
v
“Prepare samples for electrophoresis” on page 39
v

Analyze data

“Set up the GeneMapper™ ID-X Software for analysis (before first use of the kit)” on page 43
“Create an analysis method” on page 48
“Create a size standard definition file” on page 56
“Analyze and edit sample files with GeneMapper™ ID-X Software” on page 58

“Examine or edit a project” on page 59
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Perform PCR

B Optimize PCR cycle number (before first use of the kit) .............. ... .. ... . i 18
B Before YyoU Degin .. ..o e e e 19
B Treated paper substrates: prepare the amplification kit reactions ........................... 20
B Untreated paper substrates: prepare the amplification kit reactions ......................... 22
B Swab substrates: prepare the amplification kit reactions .............. ... .. ... ... . oL 24
B Perform PO R .o 28

Optimize PCR cycle number (before first use of the kit)

Before using the VeriFiler™ Express kit for the first time, perform a single initial sensitivity experiment

to determine the appropriate cycle number to use during internal validation studies and operational use
of the kit. This experiment accounts for instrument-to-instrument and sample-to-sample variations. If
you are processing multiple sample type and substrate combinations (for example, buccal samples on
treated paper and buccal samples on swabs), perform separate sensitivity experiments for each sample
type and substrate to be used for testing.

Procedural guidelines Optimize PCR cycle number

* Use 19 samples so that you can complete electrophoresis using a single 96-well plate. This
minimizes the impact of run-to-run variation on the results. Additional samples may be used for
a more comprehensive sensitivity experiment. Examples of PCR and electrophoresis plate layouts
are provided on page “Example PCR plate layout” on page 129.

¢ To maximize result quality, prepare and amplify Plate 1, then repeat for Plates 2, 3, and 4. Do not
prepare all 4 plates before amplification.

¢ To minimize the effect of instrument-to-instrument variation, use the same thermal cycler to amplify
all 4 plates.

Select samples and prepare plates

1. Select 19 of each sample+substrate type. Ensure that the selected samples represent a "typical"
range of samples analyzed in your laboratory.

2. Prepare the samples and the reactions as described in the appropriate protocols later in this
chapter. Prepare sufficient PCR reagents to complete amplification of three replicate plates.

3. Create the first of 4 identical PCR plates (see page “Example PCR plate layout” on page 129 for a
suggested plate layout).

18 VeriFiler™ Express PCR Ampilification Kit User Guide



Chapter 2 Perform PCR P‘,;E'l;"ﬂ
Before you begin

4. Amplify each plate using a different cycle number to determine the optimum conditions for use in
your laboratory.

Suggested cycle numbers for different sample type and substrate combinations are listed in the
following table.

Substrate
Sample type
Treated paper Untreated paper Swab
Blood 25, 26, 27, 28 cycles 25, 26, 27, 28 cycles N/A
Buccal 25, 26, 27, 28 cycles 25, 26, 27, 28 cycles 25, 26, 27. 28 cycles

Determine optimum PCR conditions

1. Run the PCR products on the appropriate CE platform using the recommended protocol that is
described in Chapter 3, “Perform electrophoresis”.

2. Based on the results of the sensitivity study, select the appropriate PCR cycle number for future
experiments.

Our studies indicate the optimum PCR cycle number should generate profiles with the following
heterozygote peak heights, with no instances of allelic dropout and minimal occurrence of off-scale

allele peaks:
Instrument Heterozygous peak height
3500 Series 3,000-12,000 RFU
3130 Series 1,000-3,000 RFU
3730 Series 3,000-12,000 RFU
SeqStudio™ Genetic Analyzer 3,000-12,000 RFU

When amplifying single-source, unpurified samples, you will see greater sample-to-sample variation in
peak height than you see with purified samples. Careful optimization of the cycle number helps to
minimize this variation.

Before you begin

Thaw reagents (before first use of the kit)

Thaw the Master Mix and Primer Set.

IMPORTANT! The fluorescent dyes attached to the primers are light-sensitive. Protect the primer set,
amplified DNA, allelic ladder, and size standard from light when not in use.

IMPORTANT! Thawing is required only during first use of the kit. After first use, reagents are stored at
2°C to 8°C and do not require subsequent thawing. Do not refreeze the reagents.
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WD

Treated paper substrates: prepare the amplification kit
reactions

Sample preparation guidelines: treated paper substrate

Do not add water to the wells on the reaction plate before adding the punches. If you observe
static issues with the paper discs, you can prepare and dispense the 25-uL reaction mix into the
wells of the reaction plate before adding the punches.

Alternatively, dispense 3 L of low-TE Buffer into each sample and negative amplification control
well (not the positive amplification control wells) before adding the punches.

Make the punch as close as possible to the center of the sample to ensure optimum peak intensity.
Increasing the size of the punch may cause inhibition during PCR amplification.

For manual punching: Place the tip of a 1.2 mm Harris Micro-Punch on the card, hold the barrel of
the Harris Micro-Punch (do not touch the plunger), gently press and twist 1/4-turn, then eject the
punch in to the appropriate well on the reaction plate.

For automated punching: See the User Guide of your automated or semiautomated disc punch
instrument for proper guidance.

Prepare low-TE buffer

For optimal results, we recommend using low-TE buffer for sample preparation. Prepare it as described
in this procedure or buy it from Teknova (Cat. No. T0223).

1.

2.

3.

20

Mix together:
e 10 mL of 1 M Tris-HCI, pH 8.0
e 0.2mL of 0.5 M EDTA, pH 8.0
* 990 mL glass-distilled or deionized water

Note: Adjust the volumes accordingly for specific needs.

Aliquot, then autoclave the solutions.

Store the aliquots at room temperature.
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Treated paper substrates: prepare the amplification kit reactions

Prepare the reactions: treated paper substrate

IMPORTANT! The fluorescent dyes attached to the primers are light-sensitive. Protect the primer set,
amplified DNA, allelic ladder, and size standard from light when not in use.

If this is the first time you are using the kit, follow the instructions in “Thaw reagents (before first use of
the kit)” on page 19 before proceeding.

1. Add samples to the MicroAmp" Optical 96-well Reaction Plate:

To these wells ... Add...
Negative control 1.2 mm blank disc
Test samples 1.2 mm sample disc
Positive control For 25 and 26 cycles 3 pL of Control DNA 007
IMPORTANT! Do not add a blank disc | for 27 cycles 2 uL of Control DNA 007
to the positive control well.
For 28 cycles 1 pL of Control DNA 007

Note: The volumes of positive control are suggested amounts and can be adjusted if peak heights
are too high or too low for your optimized cycle number.

2. Vortex the Master Mix and Primer Set for 3 seconds. Before opening the tubes or bottles, remove
droplets from the caps by centrifuging the tubes briefly or tapping the bottles on the bench.

3. Pipet the required volumes of components into an appropriately sized polypropylene tube.

Reaction component Volume per reaction
Master Mix 10.0 yL
Primer Set 10.0 L

Low-TE buffer 5.0 uL

Note: Include volume for additional reactions to provide excess volume for the loss that occurs
during reagent transfers.

IMPORTANT! This kit is optimized for a 25-uL PCR reaction volume to overcome the PCR
inhibition that is expected when amplifying unpurified samples. Using a lower PCR reaction
volume may reduce the ability of the kit chemistry to generate full STR profiles. See page 116
for performance testing results using a 10-pyL PCR reaction volume.

4. Vortex the reaction mix for 3 seconds, then centrifuge briefly.

5. Dispense 25 pL of the reaction mix into each reaction well of a MicroAmp™ Optical 96-Well
Reaction Plate.

VeriFiler™ Express PCR Ampilification Kit User Guide 21




5%  Chapter 2 Perform PCR
Untreated paper substrates: prepare the amplification kit reactions

6. Seal the plate with MicroAmp™ Clear Adhesive Film (Cat. No. 4306311) or MicroAmp" Optical
Adhesive Film (Cat. No. 4311971).

IMPORTANT! We recommend adhesive film for plate sealing to provide a consistent seal across
all wells and prevent evaporation. Do not use caps, which may not provide a consistent seal across
all wells.

IMPORTANT! If you are using the GeneAmp™ PCR System 9700 with silver or gold-plated silver
block and adhesive clear film instead of caps to seal the plate wells, place a MicroAmp™ Optical
Film Compression Pad (Cat. No. 4312639) on top of the plate to prevent evaporation during
thermal cycling. Other validated thermal cyclers do not require a compression pad.

7. Centrifuge the plate at 3,000 rpm for about 20 seconds in a tabletop centrifuge with plate holders.

8. Amplify the samples as described in Chapter 2, “Perform PCR”.

IMPORTANT! This kit is not validated for use with the GeneAmp™ PCR System 9700 with the
aluminum 96-well block. Use of this thermal cycling platform may adversely affect performance of
this kit.

Untreated paper substrates: prepare the amplification kit
reactions

Sample preparation guidelines: untreated paper substrate

* Make a 1.2 mm punch as close as possible to the center of the sample to ensure optimum peak
intensity. Increasing the size of the punch may cause inhibition during PCR amplification.

* If you are using a Bode Buccal DNA Collector™, make
a 1.2 mm punch as close as possible to the tip of
the DNA collector to ensure optimum peak intensity.
A larger punch may cause inhibition during PCR
amplification.

¢ For manual punching: Place the tip of a 1.2 mm Harris
Micro-Punch on the card, hold the barrel of the Harris
Micro-Punch (do not touch the plunger), gently press
and twist 1/4-turn, then eject the punch in to the
appropriate well on the reaction plate.

@ Location of punch with a Bode Buccal
* For automated punching: See the User Guide of your DNA Collector™

automated or semiautomated disc punch instrument for
proper guidance.

22 VeriFiler™ Express PCR Ampilification Kit User Guide


https://www.thermofisher.com/search/results?query=4306311&focusarea=Search%20All&scope=PDF
https://www.thermofisher.com/search/results?query=4312639&focusarea=Search%20All&scope=PDF

Chapter 2 Perform PCR 51
Untreated paper substrates: prepare the amplification kit reactions

Prepare the reactions: untreated paper substrate

IMPORTANT! The fluorescent dyes attached to the primers are light-sensitive. Protect the primer set,
amplified DNA, allelic ladder, and size standard from light when not in use.

If this is the first time you are using the kit, follow the instructions in “Thaw reagents (before first use of
the kit)” on page 19 before proceeding.

1. Add Prep-n-Go'" Buffer (Cat. No. 4467079) to the MicroAmp™ Optical 96-Well Reaction Plate:

To these wells ... Add...

Negative control 5 pL of Prep-n-Go™ Buffer

Test samples 5 pL of Prep-n-Go™ Buffer

Positive control For 25 and 26 cycles |2 pL of Prep-n-Go " Buffer
For 27 cycles 3 pL of Prep-n-Go™ Buffer
For 28 cycles 4 uL of Prep-n-Go™ Buffer

2. Add samples to the reaction plate:

To these wells ... Add...
Negative control 1.2 mm blank disc
Test samples 1.2 mm sample disc
Positive control For 25 and 26 cycles 3 pL of Control DNA 007
IMPORTANT! Do not add a blank disc | For 27 cycles 2 pL of Control DNA 007
to the positive control well.
For 28 cycles 1 uL of Control DNA 007

Note: The volumes of positive control are suggested amounts and may be adjusted if peak
heights are too high or too low for your optimized cycle number.

3. Centrifuge the plate to ensure that the punches are immersed in the Prep-n-Go™ Buffer.

4. Vortex the Master Mix and Primer Set for 3 seconds. Before opening the tubes or bottles, remove
droplets from the caps by centrifuging the tubes briefly or tapping the bottles on the bench.

5. Pipet the required volumes of components into an appropriately sized polypropylene tube.

Reaction component Volume per reaction
Master Mix 10.0 yL
Primer Set 10.0 L
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Note: Include volume for additional reactions to provide excess volume for the loss that occurs
during reagent transfers.

IMPORTANT! This kit is optimized for a 25-uL PCR reaction volume to overcome the PCR
inhibition that is expected when amplifying unpurified samples. Using a lower PCR reaction
volume may reduce the ability of the kit chemistry to generate full STR profiles. See page 116
for performance testing results using a 10-yL PCR reaction volume.

6. Vortex the reaction mix for 3 seconds, then centrifuge briefly.

7. Dispense 20 pL of the reaction mix into each reaction well of a MicroAmp™ Optical 96-Well
Reaction Plate.

The final volume in each well is 25 pL (reaction mix plus Prep-n-Go™ Buffer and sample or positive
control).

8. Seal the plate with MicroAmp™ Clear Adhesive Film (Cat. No. 4306311) or MicroAmp™ Optical
Adhesive Film (Cat. No. 4311971).

IMPORTANT! We recommend adhesive film for plate sealing to provide a consistent seal across
all wells and prevent evaporation. Do not use caps, which may not provide a consistent seal across
all wells.

IMPORTANT! If you are using the GeneAmp™ PCR System 9700 with silver or gold-plated silver
block and adhesive clear film instead of caps to seal the plate wells, place a MicroAmp™ Optical
Film Compression Pad (Cat. No. 4312639) on top of the plate to prevent evaporation during
thermal cycling. Other validated thermal cyclers do not require a compression pad.

9. Centrifuge the plate at 3,000 rpm for about 20 seconds in a tabletop centrifuge with plate holders.

10. Amplify the samples as described in Chapter 2, “Perform PCR”.

IMPORTANT! This kit is not validated for use with the GeneAmp™ PCR System 9700 with the
aluminum 96-well block. Use of this thermal cycling platform may adversely affect performance of
this kit.

Swab substrates: prepare the amplification kit reactions

Sample preparation guidelines: swab substrate

¢ Detach each buccal swab head from the swab shaft before lysis.

* If you are using the heated lysis protocol, perform lysis in either of the following formats:
- 1.5-mL tubes with a heat block (VWR™ Scientific Select dry heat block or similar)

- PrepFiler" 96-Well Processing Plates (Cat. No. A47010)
- Robbins Scientific™ Model 400 Hybridization Incubator or similar
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- Agilent™ Benchtop Rack for 200 pL Tubes/V Bottom Plates (metal) or similar (Cat. No. 410094)

IMPORTANT! Do not use a plastic plate adaptor.

For optimum performance, lyse the entire swab. If you need to preserve the sample, use half of the
lysate prepared from the entire swab.

Prepare the sample lysate: room temperature

This protocol may improve the performance for challenging or aged samples.

1.

Add 400 pL Prep-n-Go ™ Buffer (Cat. No. 4471406) to 1.5-mL tubes or the appropriate wells of a
PrepFiler” 96-Well Processing Plate (Cat. No. A47010).

Into each tube or well, put the entire head of each swab, then let stand for 20 minutes at room
temperature (20°C to 25°C) to lyse the sample.

After 20 minutes, transfer the sample lysate out of the sample plate into tubes or plates for storage,
then discard the deep-well plate containing the swab heads.

Note: To minimize the risk of contamination, do not remove the swab heads from the sample
lysate plate before transferring the lysate.

Go to “Prepare the reactions: swab substrate” on page 26 or “Store the sample lysate” on
page 27.

Prepare the sample lysate: heat protocol

This protocol may improve the performance of challenging or aged samples.

1.

2.

Preheat the heat block to 90°C, or preheat the oven with a metal plate adaptor to 99°C.

Add 400 pL of Prep-n-Go™ Buffer (for buccal swabs, Cat. No. 4471406) to 1.5-mL tubes or to the
appropriate wells of a PrepFiler™ 96-Well Processing Plate (Cat. No. A47010).

Into each tube or well, put the entire head of each swab. If you are using tubes, cap the tubes.
Let the tubes or plate stand for 20 minutes in the preheated heat block or oven to lyse the sample.

After 20 minutes, remove the tubes or plate from the heat block or oven, then let the lysate stand
at room temperature for =15 minutes to cool the lysate (for accurate pipetting).

Transfer the sample lysate to tubes or plates for storage. Discard the 1.5-mL tubes or PrepFiler™
96-Well Processing Plate containing the swab heads.

Note: To minimize the risk of contamination, do not remove the swab heads from the sample
lysate plate before transferring the lysate.

Go to “Prepare the reactions: swab substrate” on page 26 or “Store the sample lysate” on
page 27.
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Swab substrates: prepare the amplification kit reactions

IMPORTANT! The fluorescent dyes attached to the primers are light-sensitive. Protect the primer set,
amplified DNA, allelic ladder, and size standard from light when not in use.

If this is the first time you are using the kit, follow the instructions in “Thaw reagents (before first use of
the kit)” on page 19 before proceeding.

1. Vortex the Master Mix and Primer Set for 3 seconds. Before opening the tubes or bottles, remove
droplets from the caps by centrifuging the tubes briefly or tapping the bottles on the bench.

2. Pipet the required volumes of components into an appropriately sized polypropylene tube.

Reaction component Volume per reaction
Master Mix 10.0 yL
Primer Set 10.0 L

Low-TE buffer 3.0 uL

Note: Include volume for additional reactions to provide excess volume for the loss that occurs
during reagent transfers.

IMPORTANT! This kit is optimized for a 25-uL PCR reaction volume to overcome the PCR
inhibition that is expected when amplifying unpurified samples. Using a lower PCR reaction
volume may reduce the ability of the kit chemistry to generate full STR profiles. See page 116
for performance testing results using a 10-uL PCR reaction volume.

3. Vortex the reaction mix for 3 seconds, then centrifuge briefly.

4. Dispense 23 pL of the reaction mix into each reaction well of a MicroAmp™ Optical 96-Well
Reaction Plate.

The final volume in each well is 25 pL (reaction mix plus Prep-n-Go ' Buffer or sample lysate).

5. Add samples to the MicroAmp™ Optical 96-Well Reaction Plate:

To these wells ... Add...
Test samples 2 pL of sample lysate
Positive control For 25 and 26 cycles 3 pL of Control DNA
007
For 27 cycles 2 pL of Control DNA
007
For 28 cycles 1 uL of Control DNA
007

Note: The volumes of positive control are suggested amounts and may be adjusted if peak
heights are too high or too low for your optimized cycle number.
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6. Seal the plate with MicroAmp™ Clear Adhesive Film (Cat. No. 4306311) or MicroAmp" Optical
Adhesive Film (Cat. No. 4311971).

IMPORTANT! We recommend adhesive film for plate sealing to provide a consistent seal across
all wells and prevent evaporation. Do not use caps, which may not provide a consistent seal across
all wells.

IMPORTANT! If you are using the GeneAmp™ PCR System 9700 with silver or gold-plated silver
block and adhesive clear film instead of caps to seal the plate wells, place a MicroAmp™ Optical
Film Compression Pad (Cat. No. 4312639) on top of the plate to prevent evaporation during
thermal cycling. Other validated thermal cyclers do not require a compression pad.

7. Vortex the reaction mix at medium speed for 3 seconds.
8. Centrifuge the plate at 3,000 rpm for about 20 seconds in a tabletop centrifuge with plate holders.

9. Amplify the samples as described in Chapter 2, “Perform PCR”.

IMPORTANT! This kit is not validated for use with the GeneAmp™ PCR System 9700 with the
aluminum 96-well block or the Veriti™ Thermal Cyclers. Use of these thermal cycling platforms may
adversely affect performance of this kit.

Store the sample lysate

1. Cap the sample lysate storage tubes or seal the sample lysate storage plate with MicroAmp™ Clear
Adhesive Film.

2. Store the sample lysate as needed.

Storage time Storage temperature
<2 weeks 2°C to 8°C
>2 weeks -25°C to -15°C

Note: The effects of multiple freeze/thaw cycles on the lysate have not been fully evaluated.
Therefore, multiple freeze/thaw cycles are not recommended.
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Perform PCR

IMPORTANT! This kit is validated for use with the validated thermal cyclers listed in “Instrument and
software compatibility” on page 15

1. Program the thermal cycling conditions.

IMPORTANT! If you are using the GeneAmp™ PCR System 9700, select the Max ramping mode.
If you are using the ProFlex™ 96-well PCR System, select the GeneAmp™ PCR System 9700
simulation mode.

Initial Optimum cycle number!!] .
. . Final .
incubation . Final hold
step Denature Anneal Extend extension
HOLD CYCLE HOLD HOLD
95°C, 94°C, 59°C, 65°C, 60°C, 4°C,
1 minute 3 seconds 16 seconds 29 seconds 5 minutes up to 24 hoursl?

[ See “Optimize PCR cycle number (before first use of the kit)” on page 18.
@' The infinity (c0) setting allows an unlimited hold time.

2. Load the plate into the thermal cycler, close the heated cover, then start the run.

IMPORTANT! If you are using adhesive clear film instead of caps to seal the plate wells, be sure
to place a MicroAmp " Optical Film Compression Pad (Cat. No. 4312639) on top of the plate to
prevent evaporation during thermal cycling. The ProFlex" 96-well PCR System does not require a
compression pad.

3. When the run is complete, store the amplified DNA.

If you are storing the DNA... Then place at...
<2 weeks 2°C to 8°C
>2 weeks —25°C to -15°C

IMPORTANT! Protect the amplified DNA from light.
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Perform electrophoresis

m Allelic ladder requirements for electrophoresis ........... ... i i 29
B Materials required for electrophoresis ...t e e 30
B Set up the SeqStudio™ instruments for electrophoresis (before first use of the kit) ............ 30
B Set up the 3500/3500xL instruments for electrophoresis (before first use of the kit) ........... 32
B Set up the 3130/3130xlI instruments for electrophoresis (before first use of the kit) ............ 34
B Set up the 3730/3730xl instruments for electrophoresis (before first use of the kit) ............ 36
B Prepare samples for electrophoresis ... i 39

Allelic ladder requirements for electrophoresis

To accurately genotype samples, you must run an allelic ladder with the samples.

Instrument N;:l rg;)::so:oallue:c On(ae;nljvz;::stion Number of samples per allelic ladder(s)
3500 1 per 3 injections 8 samples 23 samples + 1 allelic ladder
3500xL 1 per injection 24 samples 23 samples + 1 allelic ladder
3130 1 per 4 injections 4 samples 15 samples + 1 allelic ladder
3130x/ 1 per injection 16 samples 15 samples + 1 allelic ladder
3730/3730x/, 3 per injection 48 samples 15 samples + 1 allelic ladder
48-capillary
SeqgStudio™ 1 per 6 injections 4 samples 23 samples + 1 allelic ladder

IMPORTANT! Variation in laboratory temperature can cause changes in fragment migration speed and
sizing variation between runs. Follow the guidelines in the preceding table, which should account for
normal variation in run speed. Perform internal validation studies to verify the required allelic ladder
injection frequency, to ensure accurate genotyping of all samples in your laboratory environment.

It is critical to genotype using an allelic ladder run under the same conditions as the samples. Size
values obtained for the same sample can differ between instrument platforms, because of different
polymer matrices and electrophoretic conditions.
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Materials required for electrophoresis

Appendix B, “Required materials not supplied” lists the required materials that are not supplied with this

kit.

IMPORTANT! The fluorescent dyes attached to the primers are light-sensitive. Protect the primer set,
amplified DNA, allelic ladder, and size standard from light when not in use.

Set up the SeqStudio” instruments for electrophoresis
(before first use of the kit)

Electrophoresis software setup

The following table lists the data collection software and the run modules that you can use to analyze
PCR products generated by this kit. For details on the procedures, see the documents listed in
“Documentation and support” on page 136.

Data Collection
Software v1.2.1

ESIE PRV EEEETE Additional software Run modules and conditions
Analyzer Software
SeqStudio™ SeqgStudio™ None Run Module: HIDAnalysis

Injection Conditions: 1.2 kV/10 sec
Run Conditions: 11 kV/1,120 sec
Dye Set J6

Kit: VeriFiler" Express (to enable marker-to-marker
pull-up reduction feature)

30
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Set up the SeqStudio™ instruments for electrophoresis (before first use of the kit)

Perform spectral calibration

Perform a spectral calibration using the DS-36 Matrix Standard Kit (Dye set J6, 6-dye)

(Cat. No. 4425042).

You need to perform manual calibration for each dye set only once before first use. To determine if a
dye set requires manual calibration, review the calibration history for the dye set.

The following figure is an example of a passing 6-dye spectral calibration.

Capillary 1
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Set up the 3500/3500xL instruments for electrophoresis (before first use of the kit)

Set up the 3500/3500xL instruments for electrophoresis
(before first use of the kit)

Electrophoresis software setup
The following table lists the data collection software and the run modules that you can use to analyze

PCR products generated by this kit. For details on the procedures, see the documents listed in
“Documentation and support” on page 136.

Note: We conducted original validation studies for the kit using the 3130x/, 3500, or 3500xL
configurations. Subsequent validation studies for the kit were performed using the 3730x/ 48-capillary
configuration and the SeqStudio™ Genetic Analyzer.

. . 3500 Data
Genetic Operating Collection Additional software Plate templates, assa.y_s, run modules, and
analyzer system conditions
Software
3500 Windows™ 10 v4.0.1 None Assays: AB_J6_LS_POP4 (and _xI)
3500xL anq AB_JGQSB_LS_POP4 (and _xI),
which contain instrument protocols
AB_HID36_POP4_J6_NT3200 (and _xI) and
AB_HID36_POP4_J60OSR_NT3200 (and _xI)
All assays use the following conditions:
¢ Run Module: HID36_POP4(xl)
* Injection Conditions: 1.2 kV/15 sec
(24 sec for xl)
* Run Conditions: 13 kV/1,550 sec
* Dye Set J6 or J6-OSR
3500 Windows™ 7 v3, v3.1 None Plate templates: 6dye_36_POP4 (and _xI)
3500xL Assays (DCv3.1 and earlier): GF+Norm_POP4
. ™ (and _xI) and GF_POP4 (and _xI), which
3500 Windows 7 v2 g'%gg‘éat‘zr contain instrument protocol HID36_POP4
5 %
3500xL (and_xI)_J6_NT3200.
X (Cat. No. 4480670)
All assays use the following conditions:
3500 Windows™ v1 HID Updater e Run module: HID36_POP4(x)
3500xL Vista 3500 DC v2 . o N
(Cat. No. 4480670) Injection conditions: 1.2 kV/15 sec
(24 sec for xl)
* Run conditions: 13 kV/1,550 sec
* Dye Set J6
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Set up the 3500/3500xL instruments for electrophoresis (before first use of the kit)

Obtain and run the HID Updater (v1 and v2 software only)

Perform this procedure if you are using 3500 Series Software v1 or v2.

You can run 6-dye samples on 3500 Data Collection Software. Before running on either system for

the first time, run the HID Updater 3500 DC v2 (Cat. No. 4480670). The HID Updater installs plate
templates, assays, and instrument protocols that can be used to run VeriFiler" Express kit samples. For
more information, refer to the release notes provided with the Updater.

Note: If you have a new instrument installed by a Thermo Fisher Scientific representative, the updater
may have been run during installation.

1. Shut down the 3500/3500xL Data Collection Software.

2. Download the updater from www.thermofisher.com/us/en/home/technical-resources/
software-downloads/3500-Series-Genetic-Analyzers-for-Human-Ildentification.html.

3. Open the Read me file and review the software release notes.
4. Click the updater .exe file.
5. Follow the on-screen prompts.

6. Restart the computer.

Perform spectral calibration

Perform a spectral calibration using the DS-36 Matrix Standard Kit (Dye set J6, 6-dye)
(Cat. No. 4425042).
The following figure is an example of a passing 6-dye spectral calibration.

To enable off-scale recovery (OSR) with 3500 Series Data Collection Software 4.0.1, select the J6-OSR
dye set in the spectral calibration and use the J6 OSR assay to run samples.

= Irdemsity va Scan Mumies

Cabtwated Dats = EENEEER i o =

e B 5 523888

Intemiy e Scan Mumkar

It ety v Pl el Musmber

EEFEEEE =
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Set up the 3130/3130x! instruments for electrophoresis (before first use of the kit)

Set up the 3130/3130x/ instruments for electrophoresis
(before first use of the kit)

Electrophoresis software setup

The following table lists the data collection software and the run modules that you can use to analyze
PCR products generated by this kit. For details on the procedures, see the documents listed in
“Documentation and support” on page 136.

Note: We conducted original validation studies for the VeriFiler™ Express kit using the 3130xI, 3500,
or 3500xL configurations. Subsequent validation studies for the kit were performed using the 3730x/
48-capillary configuration and the SeqStudio™ Genetic Analyzer.

. . Data "
EETE OPErEiTiy Collection RElEiE] Run modules and conditions
Analyzer System software
Software
3130 Windows™ 7 Data 3130/3730 DC v4 | * HIDFragmentAnalysis36_POP4_1 Injection
Collection 6-Dye Module v1 conditions: 3 kV/5 sec
Software v4ll * Run conditions: 15 kV/1500 sec
* Dye Set J6
3130 x/ * HIDFragmentAnalysis36_POP4_1 Injection
conditions: 3 kV/10 sec
® Run conditions: 15 kV/1500 sec
* Dye Set J6

' Requires activation of 6-dye license.

Obtain and activate 6-dye license

1. Confirm that you are running Data Collection Software v4 (Help » About).

2. Obtain a 3130 DC v4 6-Dye Module v1 License key. Contact your local Human Identification
representative for information.

3. Ensure that all network cards in the computer are enabled.

IMPORTANT! You can run the 3130 Series Data Collection Software v4 using only the network
cards that are enabled when you activate the software license. For example, if you activate the
software when your wireless network card is disabled, you will not be able to run the software
when the wireless network card is enabled.
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Set up the 3130/3130x! instruments for electrophoresis (before first use of the kit)

4. Select Tools » License Manager to display the Software Activation dialog box.

3w Series Data Collection Software 4 Software Activation

Py

1.  Reguestlicense file for Computer ID:

d4beda7d416 d4beddard417

This ID = unigue fo this compuifer and cannot be used to obiain 2 ficense Me for another computer.

a. Enter the license key (from CD or email):

b. Enter your email address:

john.doe@thermofisher. com

c. Is this computer currently connected to the internet?

Yes. Connected. ] l Mo, Mot Connected.

2.  Retrieve the licensze file from email, then save it to the desktop of this computer.

3.  Find the license file:

4, Click Install and Validate License ]

Close

Erowse..,

5. Request the software license file by performing steps 1a, 1b, and 1c as listed on the activation

screen. The license file will be emailed to you.
6. Obtain the software license file from your email.

7. Make a copy of the software license file and keep it in a safe location.

8. Copy the software license file to the desktop of the Data Collection Software v4 computer.

9. If the Software Activation dialog box has closed, select Tools » License Manager.

10. Click Browse, then navigate to the software license file saved on your computer.

11. Click Install and Validate License.
A message is displayed when the license is installed and validated.

12. Click Close.

VeriFiler™ Express PCR Ampilification Kit User Guide
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Set up the 3730/3730x! instruments for electrophoresis (before first use of the kit)

Perform spectral calibration

Perform a spectral calibration using the DS-36 Matrix Standard Kit (Dye set J6, 6-dye)
(Cat. No. 4425042).

The following figure is an example of a passing 6-dye spectral calibration.
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Set up the 3730/3730x/ instruments for electrophoresis
(before first use of the Kit)

Electrophoresis software setup
The following table lists the data collection software and the run modules that you can use to analyze

PCR products generated by this kit. For details on the procedures, see the documents listed in
“Documentation and support” on page 136.
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Set up the 3730/3730x! instruments for electrophoresis (before first use of the kit)

e

YN

. . Data -
RIS ISR Collection Additional Run modules and conditions
Analyzer System software
Software
3730x/ | Windows™ 10 Data None GeneMapper36_POP7_1 Injection
Collection conditions: 2 kV/10 sec
Software v5 Run conditions!l: 7 kV/2,600 sec
3730 Windows™ 7 Data 3130/3730 DC v4 Dye Set J6
Collection 6-Dye Module v1
Software v4[

' To account for migration variation (particularly in larger, more complex markers such as Penta D), use a 7 kV run voltage with a customized
bin set. For information on customizing the run conditions, see the 3730x/ DNA Analyzer with 3730x! Data Collection Software 5 User Guide
(Pub. No. 100077621).

[l Requires activation of 6-dye license.

Obtain and activate the 6-dye license

1.

Confirm that you are running Data Collection Software v4 (Help » About)

2. Obtain a 3730 DC v4 6-Dye Module v1 License key. Contact Thermo Fisher Scientific for

VeriFiler™ Express PCR Ampilification Kit User Guide

information.

Ensure that all network cards in the computer are enabled.

IMPORTANT! You can run the 3730 Series Data Collection Software v4 using only the network
cards enabled when you activate the software license. For example, if you activate the software
when your wireless network card is disabled, you will not be able to run the software when the

wireless network card is enabled.
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Set up the 3730/3730x! instruments for electrophoresis (before first use of the kit)

VB

4. Select Tools » License Managerto display the Software Activation dialog box.

10.

38

3w Series Data Collection Software 4 Software Activation [&

1. Request license file for Computer ID:

002584ee13a4 002554ee13a5

This ID & unigue fo this comouter and cannot be used fo obiain 3 ficense fle for another computer.

a. Enter the license key (from CD or email):

AID-166c-95af-030c-452e-a 163-974c-e6c7-12a6

b, Enter your email address:

john. doe@lifetech. com

c. Is this computer currently connected to the internet?

Yes, Connected. | | Mo. Mot Connected.

2.  Retrieve the license file from email, then save it to the desktop of this computer.

3.  Find the license file:

Browse...

4, (Click Install and Validate License |

Close

Request the software license file by performing steps 1a, 1b, and 1c as listed on the activation
screen. The license file will be emailed to you.

Obtain the software license file from your email.

Make a copy of the software license file and keep in a safe location.

Copy the software license file to the desktop of the Data Collection Software v4 computer.
If the Software Activation dialog box has closed, select Tools » License Manager.

Click Browse, then navigate to the software license file saved on your computer.
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Prepare samples for electrophoresis

11. Click Install and Validate License.

A message is displayed when the license is installed and validated.

12. Click Close.

Perform spectral calibration

Perform a spectral calibration using the DS-36 Matrix Standard Kit (Dye set J6, 6-dye)
(Cat. No. 4425042).

The following figure is an example of a passing 6-dye spectral calibration.
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Prepare samples for electrophoresis

Prepare the samples for electrophoresis immediately before loading.

1. Pipet the required volumes of components into an appropriately sized polypropylene tube:

Reagent Volume per reaction
GeneScan™ 600 LIZ" Size Standard v2.0 0.5 pL
Hi-Di" Formamide 9.5 uL
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Prepare samples for electrophoresis

Note: Include volume for additional samples to provide excess volume for the loss that occurs
during reagent transfers.

IMPORTANT! The volume of size standard indicated in the table is a suggested amount.
Determine the appropriate amount of size standard based on your experiments and results.

. Vortex the tube, then briefly centrifuge.

Into each well of a MicroAmp™ Optical 96-Well Reaction Plate, add:
* 10 pL of the formamide/size standard mixture
* 1 pL of PCR product or Allelic Ladder

Note: For blank wells, add 10 pL of Hi-Di"" Formamide.

. Seal the reaction plate with appropriate septa, then briefly vortex and centrifuge the plate to ensure

that the contents of each well are mixed and collected at the bottom.
Heat the reaction plate in a thermal cycler at 95°C for 3 minutes.
Immediately place the plate on ice for 3 minutes.

Place the sample tray on the autosampler, then start the electrophoresis run.
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Examine or edit a project . ... ... e 59
For more information on using the GeneMapper™ ID-X Software .....................o..... 59

Overview of GeneMapper" ID-X Software

GeneMapper" ID-X Software is an automated genotyping software application for forensic casework,
databasing, and paternity data analysis.

GeneMapper™" ID-X Software v1.4 or later analyzes 4-dye, 5-dye, and 6-dye data and is required to
correctly analyze data that is generated using the VeriFiler" Express kit. After electrophoresis, the data
collection software stores information for each sample in a .fsa or .hid file. The GeneMapper™ ID-X
Software v1.4 or later allows you to analyze and interpret the data from the .fsa or .hid files.

Allelic ladder requirements for data analysis

HID analysis requires at least one allelic ladder sample per run folder. Perform the appropriate
internal validation studies before you use multiple allelic ladder samples in an analysis.

For multiple allelic ladder samples, the GeneMapper " ID-X Software calculates allelic bin offsets by
using an average of all allelic ladders that use the same panel in a run folder.

Allelic ladder samples in an individual run folder are considered to be from a single run. When the
software imports multiple run folders into a project, only the ladders in their respective run folders
are used for calculating allelic bin offsets and subsequent genotyping.

Allelic ladder samples must be labeled as "Allelic Ladder" in the Sample Type column in a project.
Analysis will fail if the Allelic Ladder Sample Type is not specified.

Injections containing the allelic ladder must be analyzed with the same analysis method and
parameter values that are used for samples, to ensure proper allele calling.
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Chapter 4 Analyze data with GeneMapper™ ID-X Software
File names and versions used in this section

* Alleles that are not in the allelic ladders do exist. Off-ladder (OL) alleles can contain full and/or
partial repeat units. An off-ladder allele is an allele that occurs outside the bin window of any
known allelic ladder allele or virtual bin.

Note: If a sample allele peak is called as an off-ladder allele, verify the sample result according to
your laboratory protocol.

File names and versions used in this section

42

The file names and version numbers of panel, bin, and stutter files that are shown in this section may
differ from the file names that you see when you download or import files.

If you need help to determine the correct files to use, contact your local Human Identification
representative, or go to thermofisher.com/support.

VeriFiler™ Express PCR Ampilification Kit User Guide


http://thermofisher.com/support

Chapter 4 Analyze data with GeneMapper™ ID-X Software S
Set up the GeneMapper™ ID-X Software for analysis (before first use of the kit)

Set up the GeneMapper" ID-X Software for analysis (before
first use of the kit)

Workflow: Set up GeneMapper™ ID-X Software

Before you use GeneMapper' ID-X Software to analyze data for the first time, you must do the
following:

“Check panel, bin, and stutter file versions on your computer” on page 43
v
“(If needed) Download newer versions of panel, bin, and stutter files” on page 44
v
“Import panels, bins, and marker stutter” on page 44
v

“(Optional) Define custom table or plot settings” on page 47

Check panel, bin, and stutter file versions on your computer
1. Start the GeneMapper'" ID-X Software , then log in with the appropriate user name and password.
2. Select Tools » Panel Manager.

3. Check the version of files that are currently available in the Panel Manager:

¥ Panel Manager ..‘
File Edit Bins View Help

a. Select Panel Manager in the navigation pane.

b. Expand the Panel Manager folder and any =
subfolders to identify the analysis file version that g x S
is already installed for your kit choice.

4. Check the version of files available for import into the Panel Manager:

a. Select Panel Manager, then select File » Import Panels to open the Import Panels dialog
box.

b. Navigate to, then open the Panels folder, then check the version of panel, bin, and stutter files
installed.

5. Check for newer versions of the files as described in the next procedure.
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| Set up the GeneMapper™ ID-X Software for analysis (before first use of the kit)
(If needed) Download newer versions of panel, bin, and stutter files
1. Go to www.thermofisher.com/GMIDXsoftware.

2. If the file versions listed are newer than the versions on your computer, download the file
VeriFilerExpress Analysis Files.

Note: When downloading new versions of analysis files, see the associated Read Me file for
details of changes between software file versions. Perform the appropriate internal validation
studies before using new file versions for analysis.

3. Unzip the file.

Import panels, bins, and marker stutter

To import the latest panel, bin set, and marker stutter from the website into the GeneMapper™ ID-X
Software database:

1. Start the GeneMapper™ ID-X Software, then log in with the appropriate user name and password.

2. Select Tools » Panel Manager. ,® Panel Manager _4

File Edit Bins View Help

3. Find, then open the folder containing the panels, bins, e ;
}':\ | j 1" .':1 ik

and marker stutter: |

o ws PEANEl Manager

a. Select Panel Manager, then select File » Import Panels to open the Import Panels dialog
box.

b. Navigate to, then open the VeriFilerExpress Analysis Files folder that you unzipped in the
previous procedure.

4. Select VeriFilerExpress_Panels.txt, then click Import.

Note: Importing this file creates a new folder in the navigation pane of the Panel Manager,
VeriFilerExpress_Panels. This folder contains the panel and associated markers.

4 Impaort Panels &
Lookin: | . VeriFilerExpress Analysis Files v 1% - ? ’-‘-‘ =
g . VeriFilerExpress_Bins_v1X.txt
-‘;r,‘? . VeriFilerExpress_Panels_v1X.tet
Recent Ttems . VeriFilerExpress_Stutter v1X.bd
Desktop File name: VeriFilerExpress_Panels_v 1. txt
" Flesoftwe: [airies =
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Set up the GeneMapper™ ID-X Software for analysis (before first use of the kit)

5. Import the bins file:

Chapter 4 Analyze data with GeneMapper™ ID-X Software

a. Select the VeriFilerExpress_Panels folder in the navigation pane.

| &~ ]

4 Panel Manager

File Edit Bins View Help

I

T e | I ‘||| 1 ‘BinSet: :'l.n'eriFilerExpress_Bins_... v| Nir & W & W

E}--@veriFilerExpress -

=l VeriFilerExpress
i D351358

- wWA

-D165539

- CSF1PO

- TPOX

- Yindel

- AMEL

-DB51179 -

| |

| r

------ d%hp.eference Samples |

Parel Hane

Clorrarierd

l_FeriFi erExpress _Panels_w1x

|nu||

[ oK H Cancel H Apply H Help ]

b. Select File » Import Bin Set to open the Import Bin Set dialog box.

c. Navigate to, then open the VeriFilerExpress Analysis Files folder.

d. Select VeriFilerExpress_Bins.txt, then click Import.

Note: Importing this file associates the bin set with the panels in the VeriFilerExpress_Panels

folder.

¥ Import Bin Set

Look in: . VeriFilerExpress Analysis Files v1¥

T || VeriFilerExpress_Bins_v1 bt
&j || VeriFilerExpress_Panels_v1 ¥ td
Recent Items || VeriFilerExpress_Stutter_v1X.td

- File name:

VeriFilerExpress_Bins_v 1. tut
Desktop  Files of type: | All Files

Cancel

VeriFiler™ Express PCR Amplification Kit User Guide

45



% Chapter 4 Analyze data with GeneMapper™ /D-X Software
T Set up the GeneMapper™ ID-X Software for analysis (before first use of the kit)

6. (Optional) View the imported panels and bins in the navigation pane: Double-click the
VeriFilerExpress_Panels folder.

The panel information is displayed in the right pane and the markers are displayed below it.

4® Panel Manager

. .

File Edit Bins View Help
@ [><|| o M M | W ™ | onset VerfieErpress fins viX HJMLwEE  SEEEBENE| e
Mk Hame | Dye Color [Min Sizn [V Size | Corete] AlL| Maker | Commmints | ¥ Baker | Ladder Alkles
|t P8 _Joue  [205  [1465 1516 [1 [one ] [%10,1L12,13,14151617,18,19,20
g [z [wwa Bz ‘151 0 zi50 "l41e |4 none ] 11,12,13,14,15,16,17,18,19,20,21,22,23,24
_;\;':sm |3 |plessae |Bue  [2215 (273§ [910° |4 rene | [
CSFPO |4 jcFR0 (Bue (w0 msm LI (1 jmone | []  (6,789,10,111215,14,15
& TPOX 5 [tPox GBue |25 [345 & G mone [ [S678510,1112,13,14,15
Vindel _|[6 [findel areen [7o5  [e7s 2 s |ore @] L2
.;:sE;m Rliearss Green (370 (1080 |y |3 rone | [ [
& D21511 e [D1179 |ereen (1085 (1765 4 fone | [] [56,7,8,5,10,11,12,13,14,15,16,17,18,19
DI18S51 T |[s petsit ereen [1795  |z4e5 317 4 Jrons | ] |24.24.2,8526,27, 9,29.2,30,30,2,31,31 38
g PentaE 10 |D18551  |Green (2555 375 [1z,150 |4 none @] 7,9,10,10.2,11,12,13,13.2,14,14 2, 15,16, 17,15, 13,20,21
D25441 = =
- pissess [11[pentzE[Grean (3995 [+65.0 5 jnone | ] |56.78910,11,12,15,14,15,16,17,18,19,20,21 4,25,26
THO1 12[D2441  [Vellow 750 (1135 ['1415" |5 nons | [] |890,1L115,12,1514,15,16,17
Q| y [ oo [veon (1555 (1795 [i415 [ jnene | ] [6088,10,01,12,122,15,132,14,14.2,15,152,16,16.2,17,17.2,102,19.2
14 [THOT velow (1740 (2195 793 (¢ |mne | []  |45678993,1011L133
aRefrence Sonples 15 [FGA Velow (2205 (3800 |- g rone | [ 13,14,15,16,17,16,15,20,21 4 5,30,30.2,31 42.2,43.2,44.2,45.2,46.2,47.2,46.2,50 2,51.2
16 02251045 [Red (535 [1285  'IL16" |3 nome | [ [8,,10,11,12,15,14,15,1%,17,15,10
|17|pss16  [Red  [1335 1895 |1l 4 none | [ |7,8,9,1011,1213,1415,1617,18
150135317 |Red (1970 [245.0 |1 4 jone [ [56.78510,11,12,1514,1516
19075820 |Red 785 (3045 7,12 |3 |none | [ |6,7,8,5,10,11,1,15,14,15
|20 [D6S1043 [Red  [305.0 3840 "2t |4 none [ ] |%10,1L,12,13,14,15,16,17,18,15,20,21,22,23,24,25
21 [DiS1z46 [Fuple (800 (1320 [IZiS 4 one | [B810,1112,13,141516,17,1818
|22|D15i6s6 [Purle (1540 (2095 [1316" |4 |rene | [] |9,00,1L12,13,14,14.3,1515.3,16,16.3,17,173,18.3,19.3,203
230125351 |Puple [2110 (2705 ["18,19" |+ |none | [] |14,1516,17,16,15,15.3,20,21,22,23,24,25,26,27
24[D25138 |Puple (2555 (3955 20,23 |4 [rone | ] |11,12,13,14,15,16,17,16,15,20,21,22,23,24,25,26, 27,28
25 [PentaD  [Puple (3700 (450 1,127 |5 |mene | []  |2232567851015,1213,14,151617

7. Import the stutter file:

a. Select the VeriFilerExpress_Panels folder in the navigation panel.

b. Select File » Import Marker Stutter to open the Import Marker Stutter dialog box.

c. Navigate to, then open the VeriFilerExpress Analysis Files folder.

d. Select VeriFilerExpress_Stutter.txt, then click Import.

Note: Importing this file associates the marker stutter ratio with the bin set in the
VeriFilerExpress_Panels folder and overwrites any existing stutter ratios associated with the
panels and bins in that folder.

r
_1¥ Export Marker Stutter e s ——

=

I
e Bt

Recent Items

Desktop

Lock in:

. VeriFilerExpress Analysis Files v 1x

-

T EE

| VeriFilerExpress_Bins_vl1X.tct
| VeriFilerExpress_Panels_v1X.bd

. VeriFilerExpress_Stutter v1X.bd

File name: VeriFilerExpress_Stutter _w1X.txt

Files of type: [l Files

[ Export Marker Stutter ]

[ Cancel ]

8. View the imported marker stutters in the navigation pane:

a. Double-click the VeriFilerExpress_Panels folder to display the folder.

b. Double-click the folder to display its list of markers below it.

46

VeriFiler™ Express PCR Ampilification Kit User Guide



Chapter 4 Analyze data with GeneMapper™ ID-X Software M
Set up the GeneMapper™ ID-X Software for analysis (before first use of the kit) =i

c. Double-click a marker to display the Stutter Ratio & Distance view for the marker in the right

pane.
=— — = = — — n
4? Panel Manager [
File Edit Bins View Help
=5 | W W | W= | s Set: VerFlerEigress_Bins_viX L ESE OEEEGENE| @
5|y VeriFilerExpress -
S0 VeriFilerExpress _f Please enter the stutter filter(s) for D2251045 marker here If left blank, the global stutter filter will be applied

D351358

viiA Minus Stutter Plus Stutter

D165539

CSFIPO Ratio From Distance To Distance Ratio From Distance To Distance

TPOX 1 . 1800 2.25 3.75 1 . 0B05 2.25 3.75

findel 3 5

AMEL

D351179 3 3

D21511 E 4 4

D18551

Fenta®

D25441

D195433

THO1 n

FGA

- g, Reference Samples

9. Click Apply, then click OK to add the panel, bin set, and marker stutter to the GeneMapper™ ID-X
Software database.

IMPORTANT! If you close the Panel Manager without clicking Apply, the panels, bin sets, and
marker stutter are not imported into the GeneMapper™ ID-X Software database.

(Optional) Define custom table or plot settings

Default views for table and plot settings are provided with the software. For information on defining
custom views, see GeneMapper" ID-X Software Getting Started Guide— Basic Features.
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=" Create an analysis method

Create an analysis method

Create an analysis method

IMPORTANT! Analysis methods are version-specific, so you must create an analysis method for each
version of the software. For example, an analysis method that is created in GeneMapper™ ID-X Software

version 1.2 is not compatible with analysis methods that are created in earlier versions of software, or
with GeneMapper™ Software v3.2.1.

1. Select Tools » GeneMapper® ID-X Manager to open the GeneMapper ID-X Manager.
[ ,* GeneMapper® ID-X mm__

Find Mame Containing:

Projects | Analysis Methods | Table Settings | Plot Settings | Matrices | Size Standards | Report Settings|

[ mew.. || open.. || savess.. || mport.. || Export.. |

ittt (somey

2. Click the Analysis Methods tab, then click New to open the Analysis Method Editor with the
General tab selected.

3. Enter the settings shown in the figures on the following pages.

Note: The Analysis Method Editor closes when you save your settings. To complete this step
quickly, do not save the analysis method until you finish entering settings in all of the tabs.

4. After you enter the settings on all tabs, click Save.
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Enter Analysis Method settings

Enter General tab settings

Chapter 4 Analyze data with GeneMapper™ ID-X Software
Create an analysis method

1. Enter a Name and select the Security Group appropriate for your software configuration.

Analysis Method Editor

XN

General | Allele | Peak Detector | Peak Quality | 5Q & GQ Settings|
—Analysis Method Description
Mame: VeriFilerExpress_AnalysisMethod _v 1¥]
Security Group: .GeneMapper ID-¥ Security Group =

i Description: | ; |
| 18 |
| |
il || Instrument: W
| |
|| Analysis Type: HID |

|
" |

|

|

|

|
i |
| ]
| |
| [ ]

|

[ Save ] [ Cancel ] [ Help ]

2. (Optional) Enter a Description and Instrument.
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M Chapter 4 Analyze data with GeneMapper™ /D-X Software
=" Create an analysis method

Enter Allele tab settings

IMPORTANT! Perform appropriate internal validation studies to determine the appropriate settings to
use.

1. Select the VeriFilerExpress_Bins_v1X bin set.

5 hl
Analysis Method Editor e

| General | Allele | Peak Detector I Peak Quality I SQ & GQ Setﬁngs|
Bin Set: .?u'eriFiIerExpress_Eins_ulx [ w -
|Ise marker-specific stutter ratio and distance if available
Marker Repeat Type: Tri Tetra Penta Hexa
| | 1
Global Cut-off Value n.z2 0.2 0.2 0.0
|| | |
MinusA Ratio 0.0 0.0 0.0 0.0
| .
MinusA Distance From 0.0 0.0 0.0 0.0 |
To (0.0 0.0 0.0 0.0 |
Global Minus Stutter Ratio 0.0 0.0 a.0 0.0 |
Global Minus Stutter Distance  From 0.0 3.25 0.0 0.0 i
Toe (0.0 4,75 0.0 0.0 i
Global Plus Stutter Ratio 0.0 0.0 0.0 0.0 |
Global Plus Stutter Distance From 0.0 0.0 0.0 0.0 |
To (0.0 0.0 0.0 0.0 |
logerin Cutoff !
Amelogenin Cuto 0.0
[ Range Filter... Factory Defaults
|
|
[ Save ] [ Cancel ] [ Help ]
IS o

Figure 3 Settings used in developmental validation of the kit

2. (Optional) To apply the stutter ratios contained in the VeriFilerExpress_Stutter.txt, select the Use
marker-specific stutter ratio and distance if available checkbox (selected by default).
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Chapter 4 Analyze data with GeneMapper™ ID-X Software ~ [EF¥
Create an analysis method

3. If using GeneMapper™ ID-X Software v1.4 or later, enter values for the 4 Marker Repeat Types.

Note: For paternity and database applications, we recommended using a 20% Global Cut-off
Value for the Tri, Tetra, and Penta loci as shown in Figure 3.

4. Enter the appropriate filter settings.
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=" Create an analysis method

Enter Peak Detector tab settings

IMPORTANT! Perform appropriate internal validation studies to determine the appropriate settings to

use.

Enter the appropriate values:

Analysis Method Editor 2|
General | Allele | Peak Detector | Peak Quality | 5Q & GQ Settings |
Peak Detection Algorithm: Advanced
Ranges Peak Detection
Analysis - Sizing - Peak Amplitude Thresholds:
|Full Range v |(AllSizes  w B: 1
Start PL:| 3400 Start Size:{60
Stop Pt: {9000 | Stop Size: 500 G | P
Y: o
—Smeoothing and Baselining :
Min. Peak Half Width: 2 \pts
Smoothing (71 Mone i 5
i i - |3
@ Light Polynomial Dearee |
(1 Heavy Peak Window Size: |13 |pts I
Baseline Window: 33 . pis e e
Peak Start: 0.0
~Size Calling Method Pesk End: 0.0
(71 2nd Order Least Squares
@ 3rd Order Least Sguares Marmalization
£ ;:' Cubic Spline Interpolation [] Use Mormalization, if applicable
(71 Local Southern Method
(71 Global Southern Method
’ Factory Defaults
Save As ] [ Save ] [ Cancel ] [ Help ]

A

Figure 4 Settings used in developmental validation of the kit
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Create an analysis method | =7

Note: When using the 3730/3730xI DNA Analyzer with POP-7" polymer only; a Smoothing setting

of None and the Peak Window Size of 9 pts, the instances of spacing failures for the D2S441 and
D1S1656 markers in some allelic ladder samples are significantly reduced. With the default Smoothing
setting of Light, failures of base-pair spacing quality assessment are observed.

Enter Peak Quality tab settings

IMPORTANT! Perform the appropriate internal validation studies to determine the heterozygous and
homozygous minimum peak height thresholds, maximum peak height threshold, and the minimum peak
height ratio threshold for interpretation of data.

Enter the following values:

Analysis Method Editor f'5__<

General | Sllels | Peak Detector | Peak Quality | S0 B 50 Setkings
Min/Max Peak Height (LPH/TMPH)

Haomozyaaous min peak height
Heterozygous min peak height

Max Peak Height (MPH)

Peak Height: Fatio {PHR
Min peak height ratio

Broad Peak (B0

UL

Max peak width (hasepairs)

Allele Mumber (AN
Max expected alleles:
For autosomal markers & AMEL

Far ¥ markers

Allelic Ladder Spike
Spike Detection Enable

Cuk-of f Yalue

8]

= — o]
) =
v
=8
1)
< £

Sample Spike Detection
Spike Detection E

’ Factory Defaults

Save As ][ Save H Cancel H Help ]
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- 7" Create an analysis method

Enter SQ and GQ tab settings

IMPORTANT! The values that are shown are the software defaults and are the values we used during
developmental validation. Perform appropriate internal validation studies to determine the appropriate
values to use.

Enter the following values:

Analysis Method Editor f'5__<

Cuality weights are between 0 and 1,
~Sample and Contral G0 \Weighting

Broad Peak (BL n.g allele Mumber (M) 1.0
Cuk of Bin Allele (BIM) n.a Low Peak Height [(LPH) 0.3
Cverlap (OWL) 0.8 Maz; Peak Height (MPH) 0.3
Marker Spike {SPE) 0.3 Off-scale (05) 0.8
BMEL Cross Check (ACC) 0.0 Peak: Height Ratio (PHR) 0.3

Contral Concordance (CC) Weight = 1.0 (Only applicable bao conkrals)

—30 Weighting

Broad Peak (B0

—allelic Ladder G0 wWeighting
Spike: (S5PK/SPK) Off-scale (03)

S & G0 Ranges

Sizing Cuality: From |0.75 tol1.0 From OO0k (025

Genotype Quality;  From  |0.75 tol.0 FromOObx (0,25

I Reset Defaults

[ Save ][ Cancel H Help ]

Note: Set the ACC GQ Weighting according to the values you determine during internal validation
studies of the ACC PQV. For example, set the ACC GQ Weighting to 0.3 or higher to flag samples in
which the Amelogenin result is anything other than X, X or X, Y, or does not agree with the results for
the Y indel marker.
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Create a size standard definition file if needed

Create a size standard definition file if needed

If you cannot use the default settings that are provided, create a new size standard definition file.

About the GS600_LIZ_ (60-460) size standard definition file

The GS600_LIZ_(60-460) size standard definition that is provided with GeneMapper™ ID-X Software
and used with the Local Southern size calling method contains the following peaks: 60, 80, 100, 114,
120, 140, 160, 180, 200, 214, 220, 240, 250, 260, 280, 300, 314, 320, 340, 360, 380, 400, 414, 420,
440, and 460.

This size standard definition has been validated for use with this kit on the genetic analyzers listed
in “Instrument and software compatibility” on page 15. If you need to create your own size standard
definition, see “Create a size standard definition file” on page 56.

If you use POP-7" polymer on a 3730 instrument

The 60 bp size-standard peak may occasionally be obscured by the primer peak. The issue can be
addressed by either of the following steps:
* Re-inject samples in which the 60 base-pair peak is not recognized.

* Use the 80-460 bp size-standard definition after performing appropriate validation studies (as a
general rule, the 60 base-pair peak is not required for accurate fragment sizing with the 3rd Order
Least Squares sizing method).

For more information, see the GeneMapper™ ID-X Software v1.4 New Features and Installation
Procedures User Bulletin (Pub. No. 4477684 Rev. B), “Known issues: 3730 DNA Analyzer sizing
failures”.
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Chapter 4 Analyze data with GeneMapper™ ID-X Software
7" Create a size standard definition file if needed

Create a size standard definition file
1. Select Tools » GeneMapper ID-X Manager to open the GeneMapper ID-X Manager.

2. Click the Size Standards tab, then click New.

| Analysis Methods | Table Settings | Plot Setings | Matrices | Sz Standards | Report Settings |

Type Drscription
Advanced

Comnes
CE_F_HID_GSS00 (75-400) |2007-08-09 13:23:5 | gmid:
CE_F_HID_G5500 (75-450) (2007-05-09 13:24:1 | gmidx
CE_G5_HID_G5500 2006-10-11 13:12:% | gicke
GSE00_LIZ Z007-06-26 10:43:1| grid
Qi
gick
qrid:
ke

GSE00_LIZ+Naormalzation_{ |2012-06-06 12:57
GEE00_LIZ+Narmalization_{ |2007-06-27 01:43:1
GHE00_LIZ_(60-460) 2012-08-06 12:21:3
GSE00_LIZ_(B0-400) 2007-06-27 01:43:1

| Fl [0

3. Specify settings in the Size Standard Editor:
a. Enter a name as shown in the following figure or enter a new name.

b. In the Security Group field, select the Security Group appropriate for your software
configuration.

c. In the Size Standard Dye field, select Orange.
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Chapter 4 Analyze data with GeneMapper™ ID-X Software ¥
Create a size standard definition file if needed ==

d. In the Size Standard Table, enter the peak sizes that correspond to your size standard.

| 4? Size Standard Editor N

Edit

—Size Standard Description
Mame: G5600_LIZ_{50-460)

Security Group: :GeneMapper ID-X Security Group

Description:

Size Standard Dye: :Drange -

—Size Standard Table

PP e
L]

Size in Basepairs
1 p0.o I "

[ Insert H Delete

80.0

100.0

$a | A M2

114.0

" 5 |1z0.0

6 (1400

m

j 7 [160.0

a8 (1500

9 [Z00.0

10 (214.0

11 (2200

12 (240.0

13 |250.0

14 (2600

15 [2G60.0

16 (300.0

17 [314.0

[ QK H Cancel ][ Help ]
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B  Chapter 4 Analyze data with GeneMapper™ ID-X Software
Analyze and edit sample files with GeneMapper™ ID-X Software

Analyze and edit sample files with GeneMapper" ID-X
Software

1. In the Project window, select Edit » Add Samples to Project, then navigate to the disk or
directory that contains the sampile files.

2. Apply analysis settings to the samples in the project.

Parameter Settings
Sample Type Select the sample type.
Analysis Method Select VeriFilerExpress_AnalysisMethod (or the name of the analysis
method you created).
Panel Select VeriFiler_Express.
Size Standard Use a size range of 60-460 bp for Local Southern size calling method or a

size range of 80-460 bp for 3rd Order Least Squares size-calling method.!"]

' The VeriFiler™ Express kit was originally validated with the GeneScan™ 600 LIZ™ Size Standard v2.0. If you use a different size
standard, perform the appropriate internal validation studies to support the use of this size standard with the VeriFiler" Express
kit.

3. Click Analyze, enter a name for the project (in the Save Project dialog box), then click OK to start
analysis.
* The status bar displays the progress of analysis as a completion bar.

* The table displays the row of the sample currently being analyzed in green (or red if analysis
failed for the sample).

* The Analysis Summary tab is displayed, and the Genotypes tab is available when the
analysis is complete.

Fie Edt Analys View Tools Admin Help
COH | WF  EEEW | BEE| > @ | raesetn | 300 s edre F@ | LPER (|2 e
[

Sampa] Arvse Sy | conotpes]

Analysis Summary Summey Generaton Date: 3 24, 214 359

Selectrun flder to dsplay: (AL

Sonplestans [ Tomorsempes ]
o

[
§ Uraraeed
o

ayeed
G nlyss Seting Changed % ]

Click a ink below to display a fitered Samples Table containing only the samples selected.

Alelic

Run Foder
5 2014:04-19:09-44-42917

o 2 Atz 8| (]
1 [
s 214041509 442927 Y - s

Control Quality per project (based on sample PQVs: SOS, SSPK, MIX, OMR, SO, C6Q)

Tota # of sanges ] @oneor ]

o o o ]
o o o
o o o

‘Sample Quality per project (based on sample PQUS: SOS, SSPK, MIX, OMR, SQ, CGQ)

[ T (] Sone ]

Samples B 2

‘Analyss Conpleted.
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Chapter 4 Analyze data with GeneMapper™ ID-X Software
Examine or edit a project

Examine or edit a project

Display electropherogram plots from the Samples and Genotypes tabs of the Project window to
examine the data.

For more information on using the GeneMapper ID-X
Software

See “Related documentation” on page 136 for a list of available documents.
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Importance of validation

Validation of a DNA typing procedure for human identification applications is an evaluation of the
efficiency, reliability, and performance characteristics of the procedure. By challenging the procedure
with samples that are commonly encountered in forensic and parentage laboratories, the validation
process uncovers attributes and limitations that are critical for sound data interpretation (Sparkes,
Kimpton, Watson, 1996; Sparkes, Kimpton, Gilbard, 1996; Wallin, 1998).

Experiment conditions

60

We conducted developmental validation experiments according to the updated and revised guidelines
from the Scientific Working Group on DNA Analysis Methods (SWGDAM, December 2012). Based on
these guidelines, we conducted experiments that comply with guidelines 2.0 and 3.0 and its associated
subsections. This DNA methodology is not novel. (Moretti et al., 2001; Frank et al., 2001; Wallin et al.,
2002; and Holt et al., 2000).

We used conditions that produced optimum PCR product yield and that met reproducible performance
standards. It is our opinion that while these experiments are not exhaustive, they are appropriate for a
manufacturer of STR kits intended for forensic and/or parentage testing use.

Note: All results were analyzed on a 3500xL Genetic Analyzer in accordance with the recommended
analysis settings that are outlined in Chapter 4, “Analyze data with GeneMapper™ ID-X Software”.
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Laboratory requirements for internal validation

Laboratory requirements for internal validation

Each laboratory using this kit must perform internal validation studies. Performance of this kit is
supported when used according to the following developmentally validated parameters. Modifications
to the protocol should be accompanied by appropriate validation studies performed by the laboratory.

Developmental validation

Except where noted, all developmental validation studies were performed using the GeneAmp™ PCR
System 9700 96-Well thermal cycler or the ProFlex PCR System according to the protocol described
in the Perform PCR chapter.

Unless otherwise indicated, the data in this chapter are from the re-validation of the NGM Detect™ kit
after redesigning the IQCL and THO1 markers. The performance of the updated kit formulation assay
is fully comparable to that of the original kit. See the Technical Note: Updated NGM Detect™ PCR
Ampilification Kit: Validation and Comparative Study for studies directly related to soil specificity and a
direct comparison of the NGM Detect™ kit original formulation to the updated formulation.

SWGDAM guideline 2.2.1

“Developmental validation is the acquisition of test data and determination of conditions and limitations
of a new or novel DNA methodology for use on forensic, database, known or casework reference
samples.” (SWGDAM, December 2012)

SWGDAM guideline 3.9.2

“The reaction conditions needed to provide the required degree of specificity and robustness should
be determined. These include, but are not limited to, thermal cycling parameters, the concentration

of primers, magnesium chloride, DNA polymerase, and other critical reagents.” (SWGDAM, December
2012)
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" Developmental validation

PCR components

We examined the concentration of each component of the kit and established that the concentration
of each component was within the range where data indicated that the amplification met the

required performance criteria for specificity, sensitivity, and reproducibility. For example, blood and
buccal samples on treated-paper substrates were amplified in the presence of varying concentrations
of magnesium chloride, and the results were analyzed on a 3500xL Genetic Analyzer (Figure 5).

The performance of the multiplex is most robust within +20% of the optimal magnesium chloride
concentration.

P gtz M20_1A0T Hid e = R = R = R = R~ R~ | Mark Sample for Deletion
f g - T 20%
S TR TRV VI | TR o T e

T PR s eozee @ @ @ @ @ @ [ Mark Sample for Deletion
) Tl
b et Ll lhl Lt 111 N

R T CRCELE [] Mark Sample for Deletion
m } : mOptimaIw
= T | T T e

PRI swreozaros @ @ @ @ @ (@ Mark Sample for Deletion
= m l : 0%
T TRV L T e e

T PR EY T ez @ |8 (8 (@ @ |8 [T Mark Sample for Deletion
l - 2%
20 W L “ A b L L

Figure 5 Blood sample on FTA" card with the VeriFiler" Express kit in the presence of varying
concentrations of magnesium chloride and analyzed on a 3500xL Genetic Analyzer (Y-axis scale 0 to
28,000 RFU).
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Developmental validation

PCR cycle number

Reactions were amplified for 24, 25, and 26 cycles on the GeneAmp™ PCR System 9700 using a blood
sample on treated paper. As expected, the amount of PCR product increased with the number of
cycles. A full profile was generated for all numbers of thermal PCR cycles (24-26) and off-scale data
were collected for several allele peaks at 26 cycles (Figure 6).

The data demonstrates that for this workflow 25 PCR cycles optimizes signal peak height and
minimizes artifactual or other undesirable peaks.

4%_BOFF-2B08.hid 24H_BOFR-2 |E |E |E |E |’B |E [ mark Sample for Deletiol
75 115 155 155 235 275 315 855 335 435
30000 ; ; :
20000 24 cycles
0000 l l l 1
L I“ Li i|.‘| I VI | B I VO Y N
&%_BOFP-2B10Nid 25H_BOFR-2 | |E | | | |0 [ Mark sample for Deletiol
75 115 155 155 235 275 315 855 335 435
30000
25 cycles
20000
l L4 L] o | |
, I I
B#_BOFF-2B11 hid 26H_BOFR-2 |ﬂ ||i | |ﬂ | |O ["] mark Sample for Deletiol
7 55 155 235 275 315 355 395 435
30000

20000 26 cycles

lm Gt e Ll

Figure 6 Representative VeriFiler" Express kit profiles obtained from amplification of blood sample on
untreated paper using 24, 25, and 26 cycles, analyzed on a 3500xL Genetic Analyzer (Y-axis scale 0 to
25,000 RFU).
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Developmental validation

Thermal cycling temperatures

64

Thermal cycling parameters were optimized using a Design of Experiments (DOE) approach that
attempts to identify the combination of temperatures and hold times that produce the best assay
performance. Optimal assay performance was determined through evaluation of assay sensitivity, peak-
height balance, and resistance to PCR inhibitors.

For example, annealing/extension temperatures of 58, 59, and 60°C were tested using a GeneAmpTM
PCR System 9700 (Figure 7). The PCR products were analyzed using an 3500xL Genetic Analyzer.

All of the tested annealing temperatures, 58 to 60°C produced robust profiles. The optimal combination
of specificity, sensitivity, and resistance to PCR inhibition was observed at 59°C. Thermal cycler
temperature is critical to assay performance; therefore, routine, regularly scheduled thermal cycler
calibration is strongly recommended.

BOFP_An&S-1404 hid BOFP_An&S-1 ,E—,E—IE—,E—IE—W [C] Mark Sample for Deletio
75 15 155 135 235 275 315 355 395 435 )
4000 l 58 OC
2000
LI o Db b1y |
BOFP_AnS3-1A02 hid BOFP_An&3-1 ,E—,E—IE—,E—IE—W [C] Mark Sample for Deletio
75 15 155 135 235 275 315 355 395 435 )
4000 59 °C
2000
W bt L b
BOFP_AnG0-1403 hid BOFP_AnG0-1 ,E—,E—IE—,E—IE—W [C] Mark Sample for Deletio

75 115 155 133 233 275 3 355 333 435

4000 60 QC

ULl i L l Ll ll 1 ll |

Figure 7 Electropherograms obtained from amplification of a blood sample on an FTA" card at annealing
temperatures of 58, 59, and 60°C, analyzed on a 3500xL Genetic Analyzer (Y-axis scale 0 to 5,000 RFU).
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Representative data for common sample and substrate types

Representative data for common sample and substrate
types

For all the representative electropherograms shown (Figure 8 through Figure 12), peak heights at the
D22S1045 marker may be elevated as compared to the other markers in the TAZ™ dye channel. This
result is typical to the assay and has no impact on the ability to generate a full STR profile.
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[] Maric Sample for Deletion

“ 40“_ - *H ﬂ F“ o
10000

| l il ) L b LA |
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Figure 8 Electropherogram of a blood sample on an FTA™ card amplified with the VeriFiler" Express kit
at a customer test site and analyzed on a 3500xL Genetic Analyzer (Y-axis scale 0 to 12,000 RFU).
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Figure 9 Electropherogram of a blood sample on a NUCLEIC-CARD" Collection Device amplified with
the VeriFiler" Express kit at a customer test site and analyzed on a 3500xL Genetic Analyzer (Y-axis scale
0 to 25,000 RFU).
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Representative data for common sample and substrate types
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Figure 10 Electropherogram of a buccal sample on an FTA" card amplified with the VeriFiler" Express kit
at a customer test site and analyzed on a 3500xL Genetic Analyzer (Y-axis scale 0 to 7,000 RFU).
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Figure 11  Electropherogram of a buccal sample on a NUCLEIC-CARD™ Collection Device amplified with
the VeriFiler" Express kit at a customer test site and analyzed on a 3500xL Genetic Analyzer (Y-axis scale
0 to 7,000 RFU).
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Figure 12 Electropherogram of a buccal sample on a cotton swab (with lysate) extracted using
Prep-n-Go  Buffer, and amplified with the VeriFiler = Express kit at a customer test site and analyzed
on a 3500xL Genetic Analyzer (Y-axis scale 0 to 25,000 RFU).

Accuracy, precision, and reproducibility
SWGDAM guideline 3.5

“Precision and accuracy of the assay should be demonstrated: Precision characterizes the degree

of mutual agreement among a series of individual measurements, values and/or results. Precision
depends only on the distribution of random errors and does not relate to the true value or specified
value. The measure of precision is usually expressed in terms of imprecision and computed as a
standard deviation of the test results. Accuracy is the degree of conformity of a measured quantity to its
actual (true) value. Accuracy of a measuring instrument is the ability of a measuring instrument to give
responses close to a true value.” (SWGDAM, December 2012)

Accuracy observation

Laser-induced fluorescence detection of length polymorphism at short tandem repeat loci is not a
novel methodology (Holt et al., 2000; and Wallin et al., 2002). However, accuracy and reproducibility of
profiles have been determined from various sample types.

The following three figures show the size differences that are typically observed between sample alleles
and allelic ladder alleles on the 3130x/, and 3500xL Genetic Analyzers with POP-4" Polymer and

the 3730x/ Genetic Analyzer with POP-7"" Polymer. The X-axis in the following figures represents the
nominal nucleotide sizes for the VeriFiler™ Express Allelic Ladder. The dashed lines parallel to the X-axis
represent the +0.25-nt windows. The y-axis represents the deviation of each sample allele size from the
corresponding Allelic Ladder allele size. All sample alleles are within +£0.5 nt from a corresponding allele
in the Allelic Ladder, irrespective of the capillary electrophoresis platforms.
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Figure 13 Allele Size vs. Allelic Ladder Sizing for 84 samples analyzed on a 3130x/ Genetic Analyzer.
Size and ladder sizing for the VeriFiler" Express kit were calculated using the GeneScan" 600 LIZ" Size

Standard v2.0.
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Figure 14 Allele Size vs. Allelic Ladder Sizing for 84 samples analyzed on a 3500xL Genetic Analyzer.
Size and ladder sizing for the VeriFiler" Express kit were calculated using the GeneScan™ 600 LIZ" Size

Standard v2.0.
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Figure 15 Allele Size vs. Allelic Ladder Sizing for 84 samples analyzed on an 3730x/ Genetic Analyzer.
Size and ladder sizing for the VeriFiler" Express kit were calculated using the GeneScan" 600 LIZ" Size
Standard v2.0.

Precision and size window description

Sizing precision enables the determination of accurate and reliable genotypes. The recommended
method for genotyping is to use a +0.5-nt “window” around the size obtained for each allele in

the allelic ladder. A +0.5-nt window allows for the detection and correct assignment of alleles. Any
sample allele that sizes outside the specified window could be either:

* An “off-ladder” allele, that is, an allele of a size that is not represented in the allelic ladder.
* An allele that does correspond to an allele in the allelic ladder, but whose size is just outside a
window because of measurement error.

The measurement error inherent in any sizing method can be defined by the degree of precision in
sizing an allele multiple times. Precision is measured by calculating the standard deviation in the size
values obtained for an allele that is run in several injections on a capillary instrument.
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Figure 16 lists typical precision results obtained from multiple runs of the VeriFiler" Express Allelic
Ladder using the GeneScan™ 600 LIZ™ Size Standard v2.0. The results were obtained within a set
of injections on a single capillary array. The number of repeated injections for each genetic analyzer
platform is shown in the following table:

CE platform Capillaries # Injections Sizing method
3130x/ 16/injection 5 3rd Order Least Square, 60-460 bp
3500 8/injection 12 3rd Order Least Square, 60-460 bp
3500xL 24/injection 4 3rd Order Least Square, 60-460 bp
3730 48/injection 4 3rd Order Least Square

The mean sizes and the standard deviation for the allele sizing were calculated for all the alleles in each
run (Figure 16). The mean range and the standard deviation range show the lowest and highest values
obtained across multiple runs.

Sample alleles can occasionally size outside of the +0.5-nt window for a respective Allelic Ladder allele
because of measurement error. The frequency of such an occurrence is lowest in detection systems
with the smallest standard deviations in sizing. The figures in “Accuracy observation” on page 67
illustrate the tight clustering of allele sizes obtained on the Applied Biosystems™ genetic analyzers,
where the standard deviation in sizing is typically less than 0.15 nt. The instance of a sample allele
sizing outside the +0.5-nt window because of measurement error is relatively rare when the standard
deviation in sizing is approximately 0.15 nt or less (Smith, 1995).

Note: The read region for the VeriFiler" Express kit is 75-465 nt.

For sample alleles that do not size within a +0.5-nt window, the PCR product must be rerun

to distinguish between a true off-ladder allele versus measurement error of a sample allele that
corresponds to an allele in the Allelic Ladder. Repeat analysis, when necessary, provides an added
level of confidence in the final allele assignment.

GeneMapper" ID-X Software automatically flags sample alleles that do not size within the prescribed
window around an allelic ladder allele by labeling the allele as OL (off-ladder).

Maximum sizing precision is obtained within the same set of capillary injections. Cross—platform

sizing differences occur due to several factors including type and concentration of polymer, run
temperature, and electrophoresis conditions. Variations in sizing can also occur between runs on the
same instrument and between runs on different instruments of the same platform type because of these
factors.

IMPORTANT! To minimize the variation in sizing between runs and to ensure accurate genotyping,
follow the guidelines in “Allelic ladder requirements for data analysis” on page 41 and use allelic ladders
obtained from the same run as samples to analyze the samples.

For more information on precision and genotyping, see Lazaruk et al., 1998 and Mansfield et al., 1998.
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In the following figure, the sizes for all the alleles across multiple injections of the VeriFiler" Express
Allelic Ladder were calculated. Each box represents the 25th through the 75th percentile of the
observed values, with the center line indicating the median. Standard error bars indicate the range of
the data, with presumed outliers (points that are different from the mean by more than twice the pooled
standard deviation) shown as black dots. Panel B shows the distribution of the standard deviations for
all the markers combined for each CE instrument platform.
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Extra peaks in the electropherogram

Causes of extra peaks

Peaks other than the target alleles may be detected on the electropherogram. Causes for the
appearance of extra peaks include stutter products, incomplete 3" A nucleotide addition (at the n-1
position), dye artifacts, and mixed DNA samples (see DNA Advisory Board (DAB) Standard 8.1.2.2).

Extra peaks: Stutter

Stutter definition

Stutter is a well-characterized PCR artifact that refers to the appearance of a minor peak one repeat
unit smaller than the target STR allele product (minus stutter), or less frequently, one repeat larger (plus
stutter) (Butler, 2005; Mulero et al., 2006). Sequence analysis of stutter products at tetranucleotide STR
loci has revealed that the minus stutter product is missing a single tetranucleotide core repeat unit
relative to the main allele (Walsh et al., 1996). Although plus-stutter is normally much less significant
than minus-stutter in STR loci with tetranucleotide repeats, the incidence of plus-stutter may be more
significant in trinucleotide repeat-containing loci.

Contact HID Support for more information on plus stutter.

The proportion of the stutter product relative to the main allele (percent stutter) is measured by dividing
the height of the stutter peak by the height of the main allele peak.

Stutter observations

The level of stutter in this kit is normal and as expected for STR chemistries that are designed to
overcome inhibitors and obtain robust performance with single source reference samples. Note the
following:

Peak heights were measured for amplified samples at the loci used in the kit. All data were generated
on the 3500xL Genetic Analyzer. Some conclusions from these measurements and observations are:
* For each locus, the stutter percentage generally increases with allele length.
¢ Smaller alleles display a lower level of stutter relative to the longer alleles within each locus.
* Each allele within a locus displays a consistent stutter percentage.

* Peaks in the stutter position that are above the stutter filter percentage specified in the software
are not filtered (stutter filter percentage is calculated as the mean stutter for the locus plus three
standard deviations). Peaks in the stutter position that have not been filtered and remain labeled
can be further evaluated.

* The measurement of stutter percentage for allele peaks that are off-scale may be unusually high
due to artificial truncation of the main allele peak.

Marker-specific stutter observed in the population study with the VeriFiler" Express kit is shown in
Figure 17 through Figure 23 and listed in Table 3.

The stutter filter settings that are derived from this data are listed in “Stutter percentage filter settings
provided with GeneMapper™ ID-X Software” on page 81.
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Workflow Number of samples

Treated paper 49 blood samples on FTA™ Classic Cards
Untreated paper 425 blood samples on FTA™ Bloodstain Cards
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Figure 17 Stutter percentages for D1S1656, D2S441, D2S1338, and D3S1358 loci (Blue=FAM™ dye,
black=NED™ dye, purple=SID™ dye)
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Stutter percentage filter settings provided with GeneMapper™ ID-X Software

The settings in Table 3 were derived using the data shown earlier in this section. The proportion of
the stutter product relative to the main allele (stutter percent) is measured by dividing the height of the
stutter peak by the height of the main allele peak.

IMPORTANT! The values that are shown in the table are the values that were determined during
developmental validation studies using specific data sets. Always perform internal validation studies to
determine the appropriate values to use for your applications.

Table 3 Marker-specific stutter filter percentages for VeriFiler" Express kit loci

Locus [ % Stutter
CSF1PO 10.54
D10S1248 12.27
D12S391 14.44
D13S317 10.10
D16S539 10.76
D18S51 14.15
D19S433 10.77
D1S1656 13.62
D21S11 12.24
D22S1045 8.05
D2251045 (+3 nt) 18.0
D251338 13.29
D2S441 9.40
D3S1358 12.16
D5S818 10.53
D7S820 9.39
D8S1179 10.85
FGA 12.27
Penta D 4.09
Penta E 8.31
THO1 4.93
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Table 3 Marker-specific stutter filter percentages for VeriFiler Express kit loci (continued)

Locus [ % Stutter
TPOX 5.20
vWA 13.18

' These percentages are used as stutter filters in VeriFilerExpress_Stutter.txt.

Extra peaks: Addition of 3' A nucleotide

3’ A nucleotide addition definition

Many DNA polymerases can catalyze the addition of a single nucleotide (predominantly adenosine) to
the 3’ ends of double-stranded PCR products (Clark, 1988; Magnuson et al., 1996). This nontemplate
addition results in a PCR product that is one nucleotide longer than the actual target sequence. The
PCR product with the extra nucleotide is referred to as the “+A” form.

3’ A observations

The efficiency of +A addition is related to the particular sequence of the DNA at the 3" end of the PCR
product.

The VeriFiler™ Express kit includes two main design features that promote maximum +A addition:
* The primer sequences have been optimized to encourage +A addition.

* The PCR chemistry allows complete +A addition with a short final incubation at 60°C for
5 minutes .

This final extension step gives the DNA polymerase additional time to complete +A addition to all
double-stranded PCR products. Figure 24 shows examples of incomplete and normal +A addition. Final
extension incubation for longer than the recommended time can result in double +A addition, in which
two nontemplate adenosine residues are added to the PCR product. Double +A addition can cause
"shoulders" on the right side of main allele peaks, and is therefore to be avoided.
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Figure 24 Omitting the final extension step results in shoulders on main allele peaks due to incomplete
A nucleotide addition. Examples shown are the smaller amplicons of FAM™, NED™, and SID™ dye channel
data from a 3500xL Genetic Analyzer using the VeriFiler" Express kit.

Due to improved PCR buffer chemistry, the lack of +A addition is generally less of an issue with the
VeriFiler™ Express kit than with earlier generation kits. However, "shouldering” of allele peaks can still
be observed if the amount of input DNA is greater than recommended concentration. Amplification of
excess input DNA can also result in off-scale data.

Extra peaks: Artifacts
Artifact definition

Artifacts and anomalies are seen in all molecular biological systems. Artifacts are typically reproducible.
Anomalies are non-reproducible, intermittent occurrences that are not observed consistently in a
system (for example, spikes and baseline noise).
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Artifact observation

Due to improvements in PCR primer manufacturing processes, the incidence of artifacts has been
greatly reduced in the VeriFiler™ Express kit. Kit electropherograms are free of reproducible dye artifacts
in the kit read region of 75-465 nt for commonly used analytical thresholds. Figure 25 shows the low

baseline-level fluorescence that is observed in a typical negative control PCR.
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Figure 25 Examples of fluorescence background in data produced on a 3500xL Genetic Analyzer (Y-axis

scale 0 to 200 RFU).

Additional reproducible DNA-dependent artifacts have been characterized and documented in Table 4.
It is important to consider noise and other amplification-related artifacts when interpreting data.

Table 4 DNA-dependent artifacts observed with the VeriFiler" Express kit

Artifact Color Size Type
TAZ60-80 Red 60-80 nt PCR artifact
SID130 Purple 130-131 nt PCR artifact
SID202 Purple 202-203 nt PCR artifact
SID402-411 Purple 402-411 nt PCR artifact
VIC110-120 Green 110-120 nt Sample-independent

artifact intrinsic to the

assay
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Characterization of loci

SWGDAM guideline 3.1

“The basic characteristics of a genetic marker should be determined and documented.” (SWGDAM,
December 2012)

Loci in this kit

This section describes basic characteristics of the 23 autosomal STR loci, one Y indel locus, and the
sex-determining marker (Amelogenin), which are amplified with the VeriFiler" Express kit. Most of these
loci have been extensively characterized by other laboratories.

Nature of polymorphisms

The primers for the Amelogenin locus flank a 6-nucleotide deletion in intron 1 of the X homolog.
Amplification generates 104-nt and 110-nt products from the X and Y chromosomes, respectively.
(Sizes are the actual nucleotide size according to sequencing results, including 3” A nucleotide addition,
and size may not correspond exactly to allele mobility observed on capillary electrophoresis platforms.)
Except for D22S1045, a trinucleotide STR locus, and Penta D and Penta E, pentanucleotide STR loci
(Bacher and Schumm, 1998), the remaining loci are tetranucleotide short tandem repeat (STR) loci. The

length differences among alleles of a particular locus are caused by differences in the number of repeat
units.

We have sequenced all the alleles in the VeriFiler™ Express kit Allelic Ladder, including microvariants.
In addition, other groups in the scientific community have sequenced alleles at some of these loci
(Nakahori et al., 1991; Puers et al., 1993; Moller et al., 1994; Barber et al., 1995; Méller and Brinkmann,
1995; Barber et al., 1996; Barber and Parkin, 1996; Brinkmann et al., 1998; Momhinweg et al., 1998;
Watson et al., 1998). Among the various sources of sequence data on the loci, there is consensus on
the repeat patterns and structure of the STRs.

Inheritance

The Centre d'Etude du Polymorphisme Humain (CEPH) has collected DNA from families of Utah
Mormon, French Venezuelan, and Amish descent. These DNA sets have been extensively studied all
over the world and are routinely used to characterize the mode of inheritance of various DNA loci.
Each family set contains three generations, generally including four grandparents, two parents, and
several offspring. Consequently, the CEPH family DNA sets are ideal for studying inheritance patterns
(Begovich et al., 1992).

Mapping

The VeriFiler™ Express kit loci have been mapped, and the chromosomal locations have been published
(Nakahori et al., 1991; Edwards et al., 1992; Kimpton et al., 1992; Mills et al., 1992; Sharma and Litt,
1992; Li et al., 1993; Straub et al., 1993; Barber and Parkin, 1996; and Lareu, et al., 1996).
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Genetic linkage

Two sets of STR loci in the VeriFiler™ Express kit are located on the same chromosomes. VWA and
D12S391 are located approximately 6.3 million bp apart on the p arm of chromosome 12; D2S1338 and
D2S441 are located approximately 150 million bp apart on opposite arms of chromosome 2. Linkage
disequilibrium analysis was conducted on the genotype results from 1,034 individuals of three ethnic
groups (350 African American, 349 Caucasian, and 335 Hispanic). STR locus genotype results from the
population study were analyzed using the Linkage Disequilibrium module of GenePop software version
4.0.10 (Raymond and Rousset, 1995; Rousset, 2008). See Table 5 for results.

The relatively high probability values indicate that there is no statistically significant linkage
disequilibrium found between the pairs of loci that are located on the same chromosome.

An independent analysis of data from the same collection of population samples (Budowle, et al., 2010)
also concluded that the 15 STR loci that are shared between the NGM™ and NGM SElect™ kits were
independent at the population level (note that the SE33 locus was not part of this analysis). Therefore,
to calculate the rarity of a profile for comparison to single-source and mixture samples, the frequencies
of all loci including VWA and D12S391 could be multiplied. However, the analysis of the CEPH pedigree
families demonstrated a degree of linkage between VWA and D12S391 that does not support the
assumption of independence for kinship analysis.

Table 5 GenePop software LD Result (p-value for pairwise analysis of loci)

Chromosome African- : . .
Chromosome Nuclear Amer Caucasian Hispanic
Locus » ; merican
map positionl'] Coordinates(!] (n = 350) (n = 293)
(million bp) (n = 350)
VWA 12p13.31 5.9
0.86 0.29 0.27
D12S391 12p13.2 12.2
D2S441 2p14 68
0.11 0.32 0.19
D2S1338 2935 218

' STR locus mapping data was obtained from the NCBI Map Viewer http://www.ncbi.nlm.nih.gov/projects/mapview/
map_search.cgi?taxid=9606 or the UCSC Genome Browser (http://genome.ucsc.edu/). GenePop LD analysis probability results
(p values) greater than 0.05 were considered to indicate that linkage disequilibrium between the loci within the population tested was
not statistically significant.

Species specificity
SWGDAM Guideline 3.2

“The ability to detect genetic information from non-targeted species (e.g., detection of microbial DNA in
a human assay) should be determined. The detection of genetic information from non-targeted species
does not necessarily invalidate the use of the assay, but may help define the limits of the assay.”
(SWGDAM, December 2012)
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Nonhuman studies

The VeriFiler" Express kit provides the required specificity for detecting human alleles. Species
specificity testing was performed to ensure that there is no cross-reactivity with nonhuman DNA that
may be present in forensic casework samples.

The following species were tested (in the specified amounts) using standard PCR and capillary
electrophoresis conditions for the VeriFiler™ Express kit kit:

* Primates: chimpanzee, gorilla, and orangutang (1.0 ng each)

* Non-primates: cow, chicken, dog, horse, mouse, pig, rabbit, rat, sheep (10.0 ng each)

* Microorganisms: Candida albicans, Enterococcus faecalis, Escherichia coli, Fusobacterium
nucleatum, Lactobacillus casei, Staphylococcus aureus, Streptococcus mitis, Streptococcus
mutans, Streptococcus salivarius, and Streptococcus viridans (equivalent to 105 copies) (These
microorganisms are commonly found in the oral cavity (Suido et al., 1986; Guthmiller et al., 2001).)

Results were evaluated for the presence of any amplified peaks that would indicate cross reactivity of
the VeriFiler™ Express kit with any of these non-human species.

“Nonhuman studies” on page 87 shows example electropherogram results from the species specificity
tests. The chimpanzee, gorilla, and orangutang DNA samples produced partial profiles in the 75-465

nucleotide region.
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Figure 26 Representative electropherograms for some species tested in a species specificity study. Data
produced on a 3500xL Genetic Analyzer.

Among the non-primate species, most produced no peaks over a threshold of 175 RFU. Horse yielded
reproducible VIC™ dye peaks at 94 bp (<100 RFU) due to Amelogenin cross-reactivity. Pig yielded
reproducible TAZ™ dye peaks at 424 bp (<200 RFU). Individual replicate PCRs of dog, mouse, and

chicken yielded single, small (<50 RFU), non-reproducible peaks.

VeriFiler™ Express PCR Ampilification Kit User Guide

87



F=® Chapter 5 Experiments and results
Sensitivity

Sensitivity
SWGDAM guideline 3.3

“The ability to obtain reliable results from a range of DNA quantities, to include the upper and lower
limits of the assay, should be evaluated.” (SWGDAM, December 2012)

Sample collection factors that can affect DNA quantity

The VeriFiler" Express kit has been optimized at 25 pL PCR reaction volume to overcome the PCR
inhibition expected when amplifying:

* Blood samples that are obtained directly from unpurified 1.2 mm treated paper discs

* Buccal cells that are obtained directly from unpurified 1.2 mm treated paper discs (with the addition
of Prep-n-Go™" Buffer)

e Buccal swab sample lysate is prepared using Prep-n-Go" Buffer
Depending on the following conditions, DNA quantities present on the 1.2 mm disc may vary from
laboratory to laboratory:

* Volume of blood that is spotted onto the treated paper

* Collecting devices that are used

* (Collection methods that are applied

* Swab-to-paper transfer protocol that is used

It is essential to optimize the PCR conditions for types of blood samples and spotting protocol. See
“Optimize PCR cycle number (before first use of the kit)” on page 18.

Effect of DNA quantity on results

If too much DNA is added to the PCR reaction, the increased amount of PCR product that is generated
can result in:

* Fluorescence intensity that exceeds the linear dynamic range for detection by the instrument
(“off-scale” data).
Off-scale data is a problem because:

— Quantitation (peak height and area) for off-scale peaks is not accurate. For example, an allele
peak that is off-scale can cause the corresponding stutter peak to appear higher in relative
intensity, thus increasing the calculated percent stutter.

— Multicomponent analysis of off-scale data is not accurate. This inaccuracy results in poor
spectral separation (“pull-up”).

* Incomplete +A nucleotide addition.

To ensure minimal occurrence of offscale data when using the VeriFiler™ Express PCR Amplification Kit ,
optimize PCR cycle number according to instructions in the Perform PCR chapter.

When the total number of allele copies added to the PCR is extremely low, unbalanced amplification of
the alleles may occur because of stochastic fluctuation.
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Population data

SWGDAM guideline 3.7

“The distribution of genetic markers in populations should be determined in relevant population
groups.” (SWGDAM, December 2012)

Population data overview

To interpret the significance of a match between genetically typed samples, you must know the
population distribution of alleles at each locus in question. If the genotype of the relevant evidence
sample is:

¢ Different from the genotype of the reference sample for a suspect, then the suspect is excluded as
the donor of the biological evidence that was tested. An exclusion is independent of the frequency
of the two genotypes in the population.

* The same as the genotype of the reference sample for a suspect, then the suspect is included as a
possible source of the evidence sample.

The probability that another, unrelated individual would also match the evidence sample is estimated by
the frequency of that genotype in the relevant populations.

Loci in this kit

This section describes basic characteristics of the 23 autosomal STR loci, one Y indel locus, and the
sex-determining marker (Amelogenin), which are amplified with the VeriFiler™ Express kit. Most of these
loci have been extensively characterized by other laboratories.

Population samples used in these studies

Population data for loci contained in theVeriFiler™ Express PCR Ampilification Kit was obtained from
data published by (Hill et. al., 2013). See the original data at www.cstl.nist.gov/biotech/strbase/
NISTpop.htm. Ethnicities of sample donors were:

* African-American—342 samples
* Asian—97 samples

® (Caucasian—361 samples

* Hispanic—236 samples

The VeriFiler™ Express kit contains loci for which extensive population data are available.
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Concordance studies

The primer sequences used in the VeriFiler" Express PCR Ampilification Kit and GlobalFiler™ Express kit
are identical except for the D6S1043, Penta E, and Penta D loci which are not shared between the two
kits.

We compared allele calls between the VeriFiler” Express PCR Amplification Kit and the PowerPlex™ 21
System. Genotype data from 200 blood samples on FTA™Classic Cards showed 99.6% concordance
between the two kits. Null alleles were found with the PowerPlex ™ 21 System at the D5S818 and
Penta E loci. These alleles were accurately genotyped by the VeriFiler™ Express PCR Amplification Kit.

Probability of Identity definition

The P, value is the probability that two individuals selected at random will have an identical genotype
(Sensabaugh, 1982).

Probability of identity

Table 6 shows the Autosomal STR allele frequencies at VeriFiler™ Express kit loci by population group.

Table 7 shows the Probability of identity (P)) values of the VeriFiler" Express kit loci individually and
combined.

Table 6 Autosomal allele frequencies by population group for VeriFiler™ Express kit Kit STR loci.
(*=Alleles not detected)

Allele Africanj;zz;ican Asian (n = 97) U.S('nC:;Z?)Sian U?n I;Iizgg;ic
CSF1PO
5.0 x x x «
6.0 * x * *
7.0 0.0556 0.0206 * 0.0127
73 * * * x
8.0 0.0556 * 0.0055 0.0042
8.1 * x * *
9.0 0.0395 0.0670 0.0139 0.0233
9.1 * * * x
10.0 0.2500 0.2010 0.2202 0.2373
10.1 * * * *
10.2 * * * *
10.3 * * * *
11.0 0.2485 0.2165 0.3089 0.2797
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Table 6 Autosomal allele frequencies by population group for VeriFiler Express kit Kit STR loci.
(*=Alleles not detected) (continued)

Allele Afric:\nj:;g;’ican Asian (n = 97) U.S(.nC:\:Z?)sian U?n I;Iizgg)nic
11.1 * * * *
11.2 * * * *
11.3 * * * *
12.0 0.2953 0.3866 0.3601 0.3750
12 1 * x x x
123 x x * x
13.0 0.0468 0.0876 0.0817 0.0593
14.0 0.0088 0.0155 0.0097 0.0064
15.0 * 0.0052 * 0.0021
16.0 x x x x
D10S1248
7.0 * x * *
8.0 0.0029 * * *
9.0 0.0029 * * *
10.0 0.0073 0.0052 * *
11.0 0.0351 * 0.0014 0.0042
12.0 0.1301 0.0876 0.0319 0.0424
13.0 0.2339 0.3196 0.3075 0.2733
14.0 0.2763 0.2526 0.2978 0.3390
15.0 0.1974 0.2062 0.1967 0.2119
16.0 0.0877 0.0979 0.1330 0.0996
17.0 0.0249 0.0309 0.0277 0.0254
18.0 0.0015 * 0.0014 0.0021
19.0 * * 0.0028 0.0021
D12S391
13.0 * * * *
14.0 0.0015 * * *
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Table 6 Autosomal allele frequencies by population group for VeriFiler Express kit Kit STR loci.
(*=Alleles not detected) (continued)

Allele Afric:\nj:;g;’ican Asian (n = 97) U.S(.nC:\:Z?)sian U?n I;Iizgg)nic
15.0 0.0775 0.0412 0.0319 0.0445
16.0 0.0673 0.0103 0.0222 0.0424
17.0 0.1667 0.0825 0.1274 0.0763
17.1 0.0044 * * *
17.3 0.0044 * 0.0208 0.0169
18.0 0.2529 0.2629 0.1717 0.1780
18.1 0.0015 * * *
18.2 * * * *
18.3 0.0044 * 0.0249 0.0127
19.0 0.1477 0.1753 0.1247 0.1886
19.1 0.0088 * * 0.0021
19.3 0.0044 0.0052 0.0042 0.0064
20.0 0.1038 0.1959 0.1108 0.1547
20.1 0.0029 * * *
20.3 * * * *
21.0 0.0643 0.0979 0.1288 0.1123
21 1 * x x *
22.0 0.0365 0.0567 0.0956 0.0678
203 * x * x
23.0 0.0292 0.0258 0.0693 0.0572
24.0 0.0132 0.0103 0.0471 0.0169
24.3 * 0.0052 * *
25.0 0.0088 0.0155 0.0166 0.0064
26.0 * 0.0103 0.0028 0.0064
27.0 * 0.0052 0.0014 0.0064

D13S317
5.0 * x * x

VeriFiler™ Express PCR Ampilification Kit User Guide




Chapter 5 Experiments and results 78

Population data

Table 6 Autosomal allele frequencies by population group for VeriFiler Express kit Kit STR loci.
(*=Alleles not detected) (continued)

Allele Afric:\nj:;g;’ican Asian (n = 97) U.S(.nC:\:Z?)sian U?n I;Iizgg)nic
6.0 * x x x
70 x x x x
71 * x * x
8.0 0.0278 0.2216 0.1205 0.1102
8.1 * x x x
9.0 0.0336 0.1443 0.0776 0.1653
10.0 0.0307 0.1031 0.0471 0.0996
11.0 0.3099 0.2680 0.3255 0.2182
11.3 * x x x
12.0 0.4181 0.2062 0.2687 0.2352
123 * x * x
13.0 0.1404 0.0567 0.1163 0.1059
13.3 * x x x
14.0 0.0395 * 0.0429 0.0614
15.0 * * 0.0014 0.0042
16.0 * x * *
17.0 * x x *

D16S539
4.0 * x * x
5.0 0.0015 * * *
6.0 * * * *
70 * x x x
8.0 0.0322 * 0.0180 0.0191
8.3 * * * *
9.0 0.1827 0.3557 0.1066 0.1398
9.3 x x x x
10.0 0.1170 0.1649 0.0568 0.1504
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Table 6 Autosomal allele frequencies by population group for VeriFiler Express kit Kit STR loci.
(*=Alleles not detected) (continued)

Allele Afric:\nj:;g;’ican Asian (n = 97) U.S(.nC:\:Z?)sian U?n I;Iizgg)nic
11.0 0.3143 0.1907 0.3144 0.2648
11.3 * * * *
12.0 0.2047 0.1753 0.3144 0.2775
12.1 * * * *
12.2 * * * *
13.0 0.1228 0.0979 0.1634 0.1335
13.3 * * * *
14.0 0.0249 0.0155 0.0263 0.0127
15.0 * * * 0.0021
16.0 * * * *

D18S51
6.0 * x * *
7.0 * x x x
8.0 x x x x
9.0 0.0029 * * *
9.2 * x * *
10.0 0.0044 * 0.0083 0.0021
10.2 * * * *
11.0 0.0015 * 0.0097 0.0148
11.2 * * * *
12.0 0.0760 0.0361 0.1136 0.1144
12.2 * * * *
12.3 * * * *
13.0 0.0409 0.2165 0.1233 0.1229
13.1 * * * *
13.2 0.0044 * * *
13.3 * * * *
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Table 6 Autosomal allele frequencies by population group for VeriFiler Express kit Kit STR loci.
(*=Alleles not detected) (continued)

Allele Afric:\nj:;g;’ican Asian (n = 97) U.S(.nC:\:Z?)sian U?n I;Iizgg)nic
14.0 0.0716 0.2371 0.1343 0.1610
14.2 * * 0.0014 0.0021
15.0 0.1652 0.1804 0.1704 0.1589
15.2 0.0015 * * *
15.3 * * * *
16.0 0.1711 0.1289 0.1468 0.1250
16.1 * x * x
16.2 * * 0.0014 *
17.0 0.1520 0.0670 0.1385 0.1250
172 x x * x
173 * x * x
18.0 0.1213 0.0309 0.0776 0.0784
18.1 * x x x
18.2 x x * x
19.0 0.0994 0.0412 0.0402 0.0466
19.2 * x * *
20.0 0.0629 0.0258 0.0180 0.0275
20.2 * x x x
21.0 0.0102 0.0103 0.0097 0.0085
21 1 * * * *
21.2 0.0015 * * *
22.0 0.0073 0.0155 0.0069 0.0106
209 * x * x
23.0 0.0044 0.0052 * *
23.2 * * * *
24.0 0.0015 * * 0.0021
250 * x * x
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Table 6 Autosomal allele frequencies by population group for VeriFiler Express kit Kit STR loci.
(*=Alleles not detected) (continued)

Allele Afric:\nj:;g;’ican Asian (n = 97) U.S(.nC:\:Z?)sian U?n I;Iizgg)nic
26.0 * * * *
27.0 * * * *
28.0 * 0.0052 * *
D19S433
5.2 * x x x
6.0 x x * x
6.2 * x * x
7.0 * x * *
8.0 * x x x
9.0 * * * 0.0021
9.0 * x * x
10.0 0.0102 * 0.0014 0.0021
10.2 * x x x
11.0 0.0629 * 0.0055 0.0148
112 * x * x
12.0 0.1228 0.0361 0.0706 0.0657
12 1 * x x *
12.2 0.0365 0.0258 0.0014 0.0127
13.0 0.2456 0.2835 0.2548 0.2225
13.1 * * * *
13.2 0.0526 0.0206 0.0069 0.0445
14.0 0.2105 0.2990 0.3615 0.3538
14.2 0.0746 0.1031 0.0235 0.0381
14.3 * * * *
15.0 0.0804 0.0619 0.1565 0.1356
15.2 0.0614 0.1237 0.0360 0.0551
16.0 0.0044 0.0103 0.0568 0.0254
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Population data

Table 6 Autosomal allele frequencies by population group for VeriFiler Express kit Kit STR loci.
(*=Alleles not detected) (continued)

Allele Afric:\nj:;g;’ican Asian (n = 97) U.S(.nC:\:Z?)sian U?n I;Iizgg)nic
16.2 0.0263 0.0309 0.0152 0.0275
17.0 * * 0.0069 *
17.2 0.0088 0.0052 0.0014 *
18.0 * * * *
18.2 0.0029 * 0.0014 *
19.0 * * * *
19.2 * * * *

D1S1656
8.0 * x x x
9.0 x x x x
10.0 0.0146 * 0.0028 0.0064
11.0 0.0453 0.0309 0.0776 0.0275
12.0 0.0643 0.0464 0.1163 0.0890
13.0 0.1009 0.1340 0.0665 0.1144
13.3 * x * x
14.0 0.2573 0.0619 0.0789 0.1165
14.0 * x x *
14.3 0.0073 * 0.0028 0.0042
15.0 0.1579 0.2784 0.1496 0.1377
15.3 0.0292 * 0.0582 0.0508
16.0 0.1096 0.2010 0.1357 0.1758
16.1 * x x x
16.3 0.1023 0.0155 0.0609 0.0508
17.0 0.0278 0.0722 0.0471 0.0424
17 1 * x * x
17.3 0.0497 0.0876 0.1330 0.1483
18.0 0.0029 0.0155 0.0055 0.0064
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Table 6 Autosomal allele frequencies by population group for VeriFiler Express kit Kit STR loci.
(*=Alleles not detected) (continued)

Allele

African American
(n=342)

Asian (n = 97)

U.S. Caucasian
(n = 361)

U.S. Hispanic
(n = 236)

18.3

0.0234

0.0515

0.0499

0.0254

19.0

*

*

*

*

19.3

0.0073

0.0052

0.0152

0.0042

20.0

20.3

21.0

D21S11

23.2

24.0

24.2

24.3

25.0

25.2

25.3

26.0

0.0015

26.2

0.0021

27.0

0.0746

0.0275

27.1

27.2

27.3

28.0

0.0567

28.1

28.2

0.0052

28.3

29.0

0.2010

0.2022

0.2076

29.1

29.2

0.0028

0.0021
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Population data

Table 6 Autosomal allele frequencies by population group for VeriFiler Express kit Kit STR loci.
(*=Alleles not detected) (continued)

Allele Afric:\nj:;g;’ican Asian (n = 97) U.S(.nC:\:Z?)sian U?n I;Iizgg)nic
29.3 0.0015 * * *
30.0 0.1696 0.3299 0.2825 0.2733
30.1 * * * *
30.2 0.0175 0.0052 0.0291 0.0233
30.3 * 0.0103 * *
31.0 0.0789 0.1237 0.0720 0.0763
31.1 * * * *
31.2 0.0512 0.0361 0.0983 0.0996
31.3 * x x x
32.0 0.0088 0.0567 0.0055 0.0169
321 * x * x
32.2 0.0614 0.1134 0.0900 0.1271
329 * x x x
33.0 0.0044 0.0155 0.0014 0.0042
33.1 0.0029 * * 0.0021
33.2 0.0351 0.0464 0.0263 0.0339
33.3 * x x *
34.0 0.0058 * * 0.0021
34.1 * * * *
34.2 * * 0.0042 *
35.0 0.0219 * 0.0014 *
35.1 * * * *
35.2 * * * *
36.0 0.0088 * 0.0014 *
36.1 * * * *
36.2 * * * *
37.0 0.0029 * * *
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Population data

Table 6 Autosomal allele frequencies by population group for VeriFiler Express kit Kit STR loci.
(*=Alleles not detected) (continued)

Allele Afric:\nj:;g;’ican Asian (n = 97) U.S(.nC:\:Z?)sian U?n I;Iizgg)nic
37.2 * * * *
38.0 0.0015 * * *
38.2 * * * *
39.0 0.0015 * * *

D22S1045
70 x x * x
8.0 0.0073 * * *
9.0 * x * *
10.0 0.0409 * * 0.0148
11.0 0.1447 0.2010 0.1399 0.0636
12.0 0.0541 0.0052 0.0125 0.0127
13.0 0.0029 * 0.0069 0.0085
14.0 0.0775 0.0103 0.0568 0.0275
15.0 0.2515 0.3093 0.3213 0.4258
16.0 0.1915 0.2268 0.3823 0.3496
17.0 0.2091 0.2216 0.0748 0.0911
18.0 0.0146 0.0206 0.0055 0.0064
19.0 0.0058 0.0052 * *
D2S1338
10.0 * * * *
11.0 * * * *
12.0 * * * *
13.0 * * * *
14.0 * * * *
15.0 0.0015 * 0.0014 *
16.0 0.0556 0.0206 0.0374 0.0297
17.0 0.1009 0.0567 0.1856 0.1695
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Population data

Table 6 Autosomal allele frequencies by population group for VeriFiler Express kit Kit STR loci.
(*=Alleles not detected) (continued)

Allele Afric:\nj:;g;’ican Asian (n = 97) U.S(.nC:\:Z?)sian U?n I;Iizgg)nic
18.0 0.0424 0.1340 0.0734 0.0805
18.3 x x x x
19.0 0.1389 0.1804 0.1205 0.1928
19.3 * x * *
20.0 0.1038 0.1598 0.1565 0.1271
21.0 0.1360 0.0155 0.0374 0.0318
22.0 0.1374 0.0515 0.0346 0.0572
23.0 0.1038 0.1649 0.1053 0.1398
23.9 * x x x
233 x x x x
24.0 0.0833 0.1289 0.1150 0.0763
24.2 * * * *
25.0 0.0775 0.0464 0.1025 0.0784
26.0 0.0146 0.0361 0.0305 0.0169
27.0 0.0044 0.0052 * *
28.0 * * * *
29.0 * * * *

D2S441
8.0 * 0.0052 * *
8.1 * * * *
9.0 0.0029 * 0.0014 *
9.1 * 0.0052 0.0014 *
10.0 0.0848 0.2680 0.2105 0.3369
10.1 * * * *
11.0 0.3626 0.3505 0.3435 0.2987
11.1 * * * *
11.3 0.0439 0.0309 0.0609 0.0445
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Population data

Table 6 Autosomal allele frequencies by population group for VeriFiler Express kit Kit STR loci.
(*=Alleles not detected) (continued)

Allele Afric:\nj:;g;’ican Asian (n = 97) U.S(.nC:\:Z?)sian U?n I;Iizgg)nic
12.0 0.1652 0.2165 0.0471 0.0360
122 x x x x
12.3 0.0058 0.0052 0.0042 0.0021
13.0 0.0439 0.0258 0.0291 0.0233
13.3 0.0029 * * *
14.0 0.2675 0.0825 0.2410 0.2055
14.1 * x * x
14.3 0.0015 * * *
15.0 0.0190 0.0103 0.0596 0.0487
16.0 * * 0.0014 0.0021
17.0 * * * 0.0021

D3S1358
8.0 * x x x
9.0 x x x x
10.0 * x * x
11.0 * * 0.0014 *
12.0 0.0044 * * *
13.0 0.0029 * 0.0014 0.0064
13.2 * x * x
14.0 0.0906 0.0258 0.1066 0.0784
15.0 0.3085 0.3660 0.2729 0.3220
15.2 0.0015 * * *
16.0 0.3187 0.3299 0.2382 0.2797
16.2 * * * *
17.0 0.2120 0.2010 0.2105 0.1843
171 x x x x
17.2 * x * x
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Population data

Table 6 Autosomal allele frequencies by population group for VeriFiler Express kit Kit STR loci.
(*=Alleles not detected) (continued)

Allele Afric:\nj:;g;’ican Asian (n = 97) U.S(.nC:\:Z?)sian U?n I;Iizgg)nic
18.0 0.0570 0.0670 0.1510 0.1229
18.2 x x x x
19.0 0.0044 0.0103 0.0166 0.0042
20.0 * * 0.0014 0.0021
20.1 * x x x
210 x x * x

D5S818
6.0 * x * *
7.0 0.0015 0.0155 0.0028 0.0339
8.0 0.0468 0.0052 0.0055 0.0085
9.0 0.0322 0.0979 0.0416 0.0530
10.0 0.0731 0.2268 0.0554 0.0572
10.1 * * * *
11.0 0.2339 0.2680 0.3560 0.3898
11.1 * * * *
11.3 * * * *
12.0 0.3699 0.2062 0.3878 0.3390
12.1 * * * *
12.3 * * * *
13.0 0.2237 0.1649 0.1427 0.1081
14.0 0.0161 0.0155 0.0069 0.0085
14.3 * * * *
15.0 0.0029 * 0.0014 0.0021
16.0 * * * *
17.0 * * * *
18.0 * * * *
19.0 * * * *
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Population data

Table 6 Autosomal allele frequencies by population group for VeriFiler Express kit Kit STR loci.
(*=Alleles not detected) (continued)

Allele Afric:\nj:;g;’ican Asian (n = 97) U.S(.nC:\:Z?)sian U?n I;Iizgg)nic
D6S1043

70 x x x x
8.0 * * 0.0014 *
9.0 0.0015 * * *
10.0 0.0058 0.0309 0.0166 0.0042
11.0 0.1535 0.1495 0.2964 0.1780
12.0 0.2237 0.1237 0.2368 0.2055
12.3 * 0.0052 * *
13.0 0.0965 0.1237 0.0859 0.1017
14.0 0.0585 0.1546 0.0554 0.1356
15.0 0.0541 0.0361 0.0125 0.0297
16.0 0.0161 0.0052 0.0042 0.0021
17.0 0.0570 0.0722 0.0609 0.0487
172 x x x x
173 * x * x
18.0 0.1067 0.1598 0.0886 0.1081
18.1 * * * 0.0021
18.3 0.0015 * * *
19.0 0.1126 0.0928 0.0983 0.0763
19.2 * * * *
19.3 0.0015 * * 0.0021
20.0 0.0731 0.0412 0.0319 0.0318
20.3 * * * 0.0127
21.0 0.0175 0.0052 0.0097 0.0064
21.3 0.0015 * * 0.0403
22.0 * * 0.0014 *
22.3 * * * 0.0127
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Population data

Table 6 Autosomal allele frequencies by population group for VeriFiler Express kit Kit STR loci.
(*=Alleles not detected) (continued)

Allele Afric:\nj:;g;’ican Asian (n = 97) U.S(.nC:\:Z?)sian U?n I;Iizgg)nic
23.0 0.0102 * * *
23.3 * * * 0.0021
24.0 0.0058 * * *
24.3 * * * *
25.0 0.0015 * * *
26.0 0.0015 * * *

D7S820
5.0 * x * *
5.2 * x x x
6.0 0.0015 * * *
6.3 * x * x
7.0 0.0117 0.0052 0.0277 0.0106
71 * x x x
73 x x x x
8.0 0.2281 0.1289 0.1440 0.1208
8.1 * * 0.0014 *
8.2 * x * x
8.3 * x x x
9.0 0.1155 0.0464 0.1676 0.0911
9.1 * x * *
9.2 * * * x
9.3 * x x x
10.0 0.3363 0.2577 0.2562 0.3072
10.1 * * * *
10.3 * * * 0.0021
11.0 0.2032 0.3608 0.2050 0.2775
111 * x * x
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Population data

Table 6 Autosomal allele frequencies by population group for VeriFiler Express kit Kit STR loci.
(*=Alleles not detected) (continued)

Allele Afric:\nj:;g;’ican Asian (n = 97) U.S(.nC:\:Z?)sian U?n I;Iizgg)nic
11.3 * * * ¥
12.0 0.0877 0.1753 0.1593 0.1547
12.1 * * * *
12.3 * * * *
13.0 0.0146 0.0258 0.0346 0.0360
13.1 * * * *
14.0 0.0015 * 0.0042 *
14.1 * * * *
15.0 * * * *
16.0 * * * *

D8S1179
4.0 * x * *
5.0 * x x x
6.0 x x x x
7.0 * x * x
8.0 0.0073 * 0.0139 0.0148
9.0 0.0044 * 0.0055 0.0064
10.0 0.0307 0.1237 0.1025 0.0932
10.2 * x * x
11.0 0.0526 0.1186 0.0762 0.0530
12.0 0.1301 0.1186 0.1676 0.1292
123 * x x x
13.0 0.2193 0.2010 0.3296 0.2733
13.3 * * * *
14.0 0.2939 0.2010 0.1662 0.2627
15.0 0.1901 0.1289 0.1039 0.1292
15.3 * x * x
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Population data

Table 6 Autosomal allele frequencies by population group for VeriFiler Express kit Kit STR loci.
(*=Alleles not detected) (continued)

Allele Afric:\nj:;g;’ican Asian (n = 97) U.S(.nC:\:Z?)sian U?n I;Iizgg)nic
16.0 0.0643 0.0928 0.0332 0.0318
17.0 0.0044 0.0103 0.0014 0.0042
18.0 0.0029 0.0052 * 0.0021
19.0 * x * *
20.0 * x x x

FGA
12.3 * * * *
13.0 * * * *
14.0 * * * *
15.0 * * * *
15.2 * * * *
16.0 * * * *
16.1 * * * *
16.2 0.0015 * * *
17.0 * 0.0103 * 0.0021
17.2 0.0015 * * *
18.0 0.0015 0.0258 0.0249 0.0127
18.2 0.0175 * * *
19.0 0.0512 0.0567 0.0499 0.0805
19.2 0.0029 * * *
19.3 * * * *
20.0 0.0541 0.0876 0.1233 0.0847
20.1 * x * x
20.2 * * * *
20.3 * x * x
21.0 0.1228 0.1031 0.1787 0.1525
21.2 * * 0.0055 *
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Population data

Table 6 Autosomal allele frequencies by population group for VeriFiler Express kit Kit STR loci.
(*=Alleles not detected) (continued)

Allele Afric:\nj:;g;’ican Asian (n = 97) U.S(.nC:\:Z?)sian U?n I;Iizgg)nic
21.3 * * * *
22.0 0.1988 0.2423 0.2050 0.1653
29 1 * x * x
22.2 0.0044 * 0.0125 0.0042
22.3 0.0015 * * *
23.0 0.1696 0.2062 0.1524 0.1208
231 * x * x
23.2 0.0015 * 0.0028 0.0042
23.3 * x x x
24.0 0.1330 0.1495 0.1343 0.1419
241 * * * *
24.2 * 0.0052 0.0014 *
24.3 * * * *
25.0 0.1184 0.0722 0.0789 0.1186
25.1 * * * *
25.2 0.0015 * * *
25.3 * * * *
26.0 0.0702 0.0309 0.0263 0.0614
26.1 * * * *
26.2 * * * *
27.0 0.0234 0.0052 0.0042 0.0445
270 * x x x
28.0 0.0146 * * 0.0021
28.9 * * * *
29.0 0.0058 * * 0.0021
29 1 x x x x
299 * x * x
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Population data

Table 6 Autosomal allele frequencies by population group for VeriFiler Express kit Kit STR loci.
(*=Alleles not detected) (continued)

Allele

African American
(n=342)

Asian (n = 97)

U.S. Caucasian
(n = 361)

U.S. Hispanic
(n = 236)

30.0

0.0015

*

0.0021

30.2

0.0015

*

31.0

*

31.2

0.0015

32

32.2

33.2

34.2

41.2

42.2

43.2

44.2

45.2

46.2

47.2

48.2

49.2

50.2

51.2

Penta D

2.2

0.1140

0.0042

0.0169

3.2

0.0088

0.0021

5.0

0.0439

0.0064

6.0

0.0102

0.0042

0.0021

7.0

0.0439

0.0042

0.0021

7.4

8.0

0.1082

0.0052

0.0208

0.0191
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Population data

Table 6 Autosomal allele frequencies by population group for VeriFiler Express kit Kit STR loci.
(*=Alleles not detected) (continued)

Allele Afric:\nj:;g;’ican Asian (n = 97) U.S(.nC:\:Z?)sian U?n I;Iizgg)nic
9.0 0.1681 0.3144 0.2216 0.2415
9.0 x x x x
9.4 * x * x
10.0 0.0994 0.1856 0.1150 0.1568
11.0 0.1798 0.1804 0.1260 0.1568
112 x x * x
12.0 0.1082 0.1804 0.2327 0.1631
120 * x * *
13.0 0.0833 0.1031 0.1967 0.1441
13.4 0.0015 * * *
14.0 0.0249 0.0103 0.0609 0.0720
14.1 * * * *
15.0 0.0044 0.0103 0.0097 0.0106
16.0 * * 0.0028 0.0042
17.0 0.0015 * 0.0014 0.0021
18.0 * x * *

Penta E
4.0 * x x x
5.0 0.0950 0.0722 0.0762 0.0360
6.0 0.0015 * * *
7.0 0.1038 * 0.1690 0.1186
8.0 0.1667 0.0052 0.0139 0.0254
9.0 0.0512 0.0258 0.0125 0.0169
10.0 0.0468 0.0619 0.0859 0.0847
11.0 0.0643 0.1598 0.0873 0.0742
114 * * * *
12.0 0.1287 0.0928 0.1994 0.1737
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Population data

Table 6 Autosomal allele frequencies by population group for VeriFiler Express kit Kit STR loci.
(*=Alleles not detected) (continued)

Allele Afric:\nj:;g;’ican Asian (n = 97) U.S(.nC:\:Z?)sian U?n I;Iizgg)nic
13.0 0.1038 0.0515 0.0859 0.0932
14.0 0.0687 0.0515 0.0623 0.0720
14.2 * * * *
15.0 0.0556 0.1134 0.0429 0.0911
15.2 * * * *
15.4 * * 0.0014 0.0021
16.0 0.0409 0.0567 0.0512 0.0614
16.2 * * * *
16.4 * * * *
17.0 0.0439 0.0825 0.0485 0.0551
17.4 * * * *
18.0 0.0161 0.0773 0.0332 0.0339
18.4 * x x x
19.0 0.0073 0.0412 0.0152 0.0212
19.4 * 0.0103 * *
20.0 0.0044 0.0206 0.0097 0.0212
21.0 * 0.0206 0.0028 0.0064
22.0 * 0.0309 0.0014 0.0021
23.0 * 0.0206 * 0.0064
24.0 * * 0.0014 *
25.0 0.0015 0.0052 * 0.0042
26.0 * x x x
27.0 * x * x

THO1
3.0 * x * x
4.0 x x x x
5.0 0.0044 * 0.0014 *
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Population data

Table 6 Autosomal allele frequencies by population group for VeriFiler Express kit Kit STR loci.
(*=Alleles not detected) (continued)

Allele Afric:\nj:;g;’ican Asian (n = 97) U.S(.nC:\:Z?)sian U?n I;Iizgg)nic
5.3 * x x x
6.0 0.1316 0.1701 0.2355 0.2394
6.3 * x * x
7.0 0.4079 0.2680 0.1939 0.2966
73 * x x x
8.0 0.1959 0.0722 0.0956 0.0911
8.3 * x * x
9.0 0.1594 0.4433 0.1191 0.1462
9.3 0.0965 0.0412 0.3449 0.2182
10.0 0.0044 0.0052 0.0083 0.0085
10.3 * x * x
11.0 * * 0.0014 *
12.0 * * * *
13.0 * * * *
13.3 * * * *

TPOX
4.0 * x x *
5.0 * * 0.0014 *
6.0 0.0892 * 0.0014 0.0085
7.0 0.0175 * * 0.0064
71 * * * x
73 * x x x
8.0 0.3670 0.5515 0.5249 0.4852
9.0 0.1959 0.0773 0.1274 0.0932
10.0 0.0863 0.0258 0.0499 0.0487
10.1 * * * *
10.3 * * * *
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Population data

Table 6 Autosomal allele frequencies by population group for VeriFiler Express kit Kit STR loci.
(*=Alleles not detected) (continued)

Allele Afric:\nj:;g;’ican Asian (n = 97) U.S(.nC:\:Z?)sian U?n I;Iizgg)nic
11.0 0.2164 0.2990 0.2521 0.2542
12.0 0.0263 0.0464 0.0416 0.1038
13.0 0.0015 * 0.0014 *
14.0 * * * *
15.0 * * * *
16.0 * * * *

VWA
10.0 * * * *
11.0 0.0029 * * 0.0021
12.0 0.0015 * 0.0014 *
13.0 0.0088 * 0.0014 *
14.0 0.0804 0.1959 0.0928 0.0805
15.0 0.1915 0.0206 0.1053 0.1441
15.2 x x * x
16.0 0.2500 0.1392 0.2008 0.2839
17.0 0.2354 0.3144 0.2839 0.2458
18.0 0.1491 0.2062 0.2022 0.1801
18.2 * x x x
19.0 0.0629 0.1082 0.1039 0.0508
20.0 0.0161 0.0155 0.0069 0.0106
21.0 0.0015 * 0.0014 0.0021
290 * x x x
23.0 * x * x
24.0 * * * *
250 * x * x
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Table 7 Probability of identity (Pl) values for the VeriFiler” Express kit STR loci

Locus Afric(i nj;g;ican Asian (n = 97) Caucasian (n = 361) | Hispanic (n = 236)
CSF1PO 0.0828 0.0984 0.1291 0.1271
D10S1248 0.0666 0.0863 0.0979 0.1010
D12S391 0.0346 0.0444 0.0219 0.0268
D13S317 0.1339 0.0686 0.0767 0.0495
D16S539 0.0706 0.0873 0.0948 0.0742
D18S51 0.0268 0.0456 0.0284 0.0266
D19S433 0.0358 0.0676 0.0844 0.0661
D1S1656 0.0310 0.0424 0.0188 0.0242
D21S11 0.0395 0.0566 0.0497 0.0448
D2251045 0.0538 0.0967 0.1221 0.1533
D251338 0.0212 0.0307 0.0257 0.0285
D2S441 0.0937 0.1027 0.0872 0.1035
D3S1358 0.1067 0.1350 0.0768 0.0942
D5S818 0.1012 0.0721 0.1437 0.1271
D6S1043 0.0266 0.0266 0.0517 0.0285
D7S820 0.0863 0.0992 0.0597 0.0808
D8S1179 0.0650 0.0405 0.0607 0.0611
FGA 0.0289 0.0403 0.0356 0.0261
Penta D 0.0257 0.0745 0.0542 0.0460
Penta E 0.0169 0.0124 0.0211 0.0149
THO1 0.1017 0.1405 0.0919 0.0853
TPOX 0.0892 0.2233 0.1783 0.1476
VWA 0.0615 0.0759 0.0639 0.0710

Combined 2.546 x 10730 4.693 x 10728 1.092 x 10-28 2.947 x 10729
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Probability of paternity exclusion observation

The following table shows the Probability of paternity exclusion (PE) values of the VeriFiler™ Express kit
STR loci individually and combined.

The PE value is the probability, averaged over all possible mother-child pairs, that a random alleged
father will be excluded from paternity after DNA typing using the VeriFiler" Express kit STR loci
(Chakraborty, Stivers, and Zhong, 1996).

Table 8 Probability of paternity exclusion values for the VeriFiler" Express kit STR loci

Locus Afric(z; nj;z)rican Asian (n = 97) Caucasian (n = 361) Hispanic (n = 236)
CSF1PO 0.5724 0.5351 0.4708 0.4756
D10S1248 0.6138 0.5619 0.5346 0.5286
D12S391 0.7214 0.6849 0.7794 0.7559
D13S317 0.4687 0.6068 0.5877 0.6657
D16S539 0.6018 0.5580 0.5436 0.5918
D18S51 0.7555 0.6807 0.7481 0.7563
D19S433 0.7167 0.6135 0.5698 0.6172
D1S1656 0.7356 0.6916 0.7957 0.7679
D21S11 0.7028 0.6440 0.6661 0.6829
D2251045 0.6524 0.5350 0.4888 0.4388
D251338 0.7832 0.7382 0.7606 0.7474
D2S441 0.5471 0.5259 0.5616 0.5250
D3S1358 0.5158 0.4613 0.5842 0.5427
D5S818 0.5293 0.5973 0.4503 0.4825
D6S1043 0.7559 0.7562 0.6602 0.7475
D7S820 0.5615 0.5323 0.6330 0.5761
D8S1179 0.6186 0.6976 0.6302 0.6303
FGA 0.7457 0.6994 0.7173 0.7585
Penta D 0.7607 0.5908 0.6509 0.6782
Penta E 0.8069 0.8347 0.7830 0.8184
THO1 0.5259 0.4535 0.5476 0.5624
TPOX 0.5557 0.3428 0.3988 0.4452
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Chapter 5 Experiments and results
Performance of direct amplification using a 10-uL PCR reaction volume

VWA 0.6283 0.5872 0.6206 0.6009

Combined 0.999999999984527 | 0.999993438259661 | 0.999989850701339 | 0.999985788729133

Performance of direct amplification using a 10-uL PCR
reaction volume

The VeriFiler" Express PCR Amplification Kit is optimized for a 25-uL PCR reaction volume to overcome
the PCR inhibition that is expected when amplifying unpurified samples. Using a lower PCR reaction
volume may reduce the ability of the kit chemistry to generate full STR profiles with certain sample
types; however, we performed limited studies to demonstrate that the VeriFiler™ Express kit can

be used for direct amplification of reference samples with a reduced reaction volume of 10 pL.
Laboratories should perform their own validation for use of the VeriFiler" Express kit with a decreased
reaction volume. A complete developmental validation at a reduced reaction volume of 10 uL has not
been conducted.

The performance evaluation of the VeriFiler" Express kit, using a reduced reaction volume in direct
amplification, was completed with the following samples:

* Blood stain cards collected on filter paper, 1.2-mm punch size

* Blood samples collected on Whatman FTA™ cards, 1.2-mm punch size
* Buccal samples collected on Whatman FTA™ cards, 1.2-mm punch size
e Buccal samples collected on COPAN 4N6FLOQSwabs™

Except where noted, the protocols described in this user guide for the developmentally validated

25-uL PCR reaction volumes were followed for sample preparation, PCR, capillary electrophoresis, and
analysis. Table 9 lists the reagent volumes used for each substrate tested for the 10-uL PCR reaction
volume. Because of the reduced reaction volume, optimization of the appropriate PCR cycle may
require a lower cycle number to produce on-scale data than that used for a 25-uL PCR reaction volume.
See Table 9 for the cycle numbers used as part of this performance check.

Table 9 PCR preparation—reagent components and conditions for a 10-uL PCR reaction volume

Reagent volume per reaction

Sample and -
substrate type Master mix | Primer mix Low-TE Prep-n-Go ™ | o ol volume Cycle
buffer Buffer numbers
Blood on filter paper 4 uL 4 uL OpuL 2L 10 pL 24
Blood on FTA™ card 4 L 4 L 2L 0L 10 pL 24
Buccal on FTA™ card 4 L 4 L 2L opL 10 pL 27
Buccal lysate (from 4 uL 4 uL OopuL 2L 10 uL 24
swabs)
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Performance of direct amplification using a 10-uL PCR reaction volume

The success rate for the samples and substrates tested are shown in Table 10:

(B

* The full profile success rate was defined as the percent of profiles in which all peaks were above a
175-RFU peak amplitude threshold (PAT).

* (ff-scale peaks produced no artifacts that interfered with profile interpretation or artificial
suppression of signal.

* Pull-up artifacts were within 0.5 bp of the parent allele.

* Peak morphology was intact with no split peaks.

¢ Stutter peaks were not over the 20% global filter used for analysis.

Table 10 Success rate results for a 10-uyL PCR reaction volume, using a 20% global filter and a PAT of

175 RFU
sil:::gteei;ge am’:)::::tz:;fsm Partial profile No profile Off-scale alleles Sl(j1c; 5e sRsFLa)te
Blood on filter paper 200 0 0 9 100%
Blood on FTA™ card 42 0 0 7 100%
Buccal on FTA™ card 70 2 2 2 94%
Buccal lysate (from 46 0 0 1 100%
swabs)

' The number of amplifications refers to the number of unique donors tested for the particular sample type.

Our studies demonstrate that the VeriFiler™ Express kit can be used to generate full profiles from blood

and buccal reference samples prepared using a reduced PCR reaction volume of 10 pL.

There are multiple sample and substrate combinations that can be encountered that require different
cycle numbers to produce optimal data within the dynamic range of the capillary electrophoresis
instrument. In addition, sample collection techniques and collection efficiency impact the amount

of sample on the collection device and subsequent downstream profile success. Therefore, we
recommend that laboratories intending to implement a reduced reaction volume for a direct
amplification workflow using the VeriFiler™ Express kit determine the optimum cycle number based
on internal validation studies with their specific sample and substrate combinations.
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Troubleshooting

Observation

Possible cause

Recommended action

Faint or no signal from both the
DNA Control 007 and the DNA
test samples at all loci

The incorrect volume of Master
Mix or Primer Set was used.

Use the correct volume of Master Mix or Primer
Set.

The DNA Polymerase was not
activated.

Repeat the amplification with an initial hold at
95°C for 1 minute.

The Master Mix was not
vortexed thoroughly before
aliquoting.

Vortex the Master Mix thoroughly.

The Primer Set was exposed to
too much light.

Replace the Primer Set and store it protected
from light.

Evaporation.

Ensure that the plate is properly sealed with film
and that a compression pad was used with the
GeneAmp™ PCR System 9700. (A compression
pad should not be used with other validated
thermal cyclers.)

The thermal cycler
malfunctioned.

See the thermal cycler user manual and check
the instrument calibration.

Incorrect thermal cycler
conditions were used.

Use correct thermal cycler conditions.

A MicroAmp™ base was used
with a tray/retainer set and tubes
in GeneAmp™ PCR System
9700.

Remove the MicroAmp™ base.

The tubes or plate were not
seated tightly in the thermal
cycler during amplification.

Push the tubes or plate firmly into the block after
first cycle.

The wrong PCR reaction tubes
or plate were used.

Use MicroAmp™ Reaction Tubes with Caps or
the MicroAmp™ Optical 96-well Reaction Plate
for the GeneAmp"™ PCR System 9700 or Veriti "
Thermal Cycler.

Insufficient PCR product was
electrokinetically injected.

Use correct genetic analyzer settings.

Degraded formamide was used.

Check the storage of formamide. Do not
thaw and refreeze multiple times. Try Hi-Di™
Formamide.
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Appendix A Troubleshooting

Performance of direct amplification using a 10-uL PCR reaction volume

Observation

Possible cause

Recommended action

Faint no signal Control and
samples all loci

The sample punch location was
not optimal.

For blood samples on treated paper, punch in
the center of the blood stain.

For buccal samples on treated paper, punch in
the center of the buccal transfer or punch in the
optimal location you have previously determined.

For buccal samples collected with the Bode
Buccal DNA Collector™ device, punch from near
the tip of the collector.

Insufficient volume of swab
lysate was added to the
reaction.

Ensure the swab heads are incubated for
20 minutes in 400 pL of Prep-n-Go™ Buffer.

Proper low-TE buffer not used
for treated paper substrates.

Prepare low-TE buffer. See “Prepare low-TE
buffer” on page 20.

Positive signal from DNA Control
007 but partial or no signal from
DNA test samples

The test sample was diluted in
the wrong buffer (for example, a
TE buffer with an incorrect EDTA
concentration).

Redilute DNA using low-TE buffer (with 0.1 mM
EDTA).

The sample punch location was
not optimal.

For blood samples on treated paper, punch in
the center of the blood stain.

For buccal samples on treated paper, punch in
the center of the buccal transfer or punch in the
optimal location you have previously determined.

For buccal samples collected with the Bode
Buccal DNA Collector™ device, punch from near
the tip of the collector.

Insufficient lysis of the swab
head occurred.

Ensure the swab heads are incubated for
20 minutes in 400 pL of Prep-n-Go™ Buffer.

Proper low-TE buffer not used
for treated paper substrates.

Prepare low-TE buffer.

More than two alleles present at
alocus

Exogenous DNA is present in
the sample.

Use appropriate techniques to avoid introducing
foreign DNA during laboratory handling.

Stutter product (-1 repeat unit
position) was amplified.

See Chapter 5, “Experiments and results”

Triallelic patterns occur.

Confirm the triallelic pattern per the laboratory's
guidelines.

Incomplete 3" A base addition
(n—1 nt position) occured.

Include the final extension step of 60°C for
10 minutes in the PCR.

Incubate the ampilification products at 60°C for
an additional 10 minutes.

The signal exceeds the dynamic
range of the instrument and

is causing signal "pull-up" into
adjacent channels.

Ensure the cycle number is optimized. Use
fewer PCR cycles or interpret the off-scale data
according to your laboratory procedure.
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Appendix A Troubleshooting

Performance of direct amplification using a 10-uL PCR reaction volume

Observation

Possible cause

Recommended action

More than two alleles present at
a locus
(continued)

Poor spectral separation
occurred.

Perform a spectral calibration.

Confirm that Filter Set J6 modules are installed
and used for analysis.

The double-stranded DNA was
not completely denatured.

Use the recommended amount of Hi-Di™
Formamide and heat the sample plate at 95°C
for 3 minutes.

Contamination was carried over
from the disc punching tool.

Clean the disc punching tool thoroughly. If
necessary, include a blank punch step in
between the sample punches.

Poor peak height balance

Incorrect thermal cycler
conditions were used.

Use correct thermal cycler conditions.

Expected amplification pattern
observed in the TAZ™ dye
channel.

Peak heights are typically elevated at D2251045
for buccal samples. Follow laboratory guidelines
for evaluation of the generated results.

Some but not all loci visible on
electropherogram of DNA Test
Samples

The punched disc you used was
too large.

Use a 1.2 mm disc.

Insufficient lysis of the swab
head occurred.

Ensure the swab heads are incubated for
20 minutes in 400 pL of Prep-n-Go " Buffer.

The PCR reaction volume you
used is lower than the volume
required for the amplification.

Use the correct PCR reaction volume: 25 pL

STR profiles contain many off-
scale alleles

The PCR cycle number used
was too high.

Perform a sensitivity experiment to determine the
optimal PCR cycle number based on the sample
type.

Blood samples: Too much liquid
blood was spotted onto the
paper substrate.

Spot <100 pL of liquid blood per sample area.

Data collected on the
3730 instrument with POP-7™
polymer fails sizing

The 60-bp size-standard peak
is occasionally obscured by the
primer peak.

Reinject samples that fail to recognize the
60 base-pair peak.

Use the 80 to 460 bp size-standard definition
after performing appropriate validation studies
(as a general rule, the 60 base-pair peak is not
required for accurate fragment sizing using the
3rd Order Least Squares sizing method).

For more information, see the GeneMapper™
ID-X Software v1.4 New Features

and Installation Procedures User Bulletin

(Pub. No. 4477684), “Known issues: 3730 DNA
Analyzer sizing failures”.
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Appendix A Troubleshooting

Performance of direct amplification using a 10-uL PCR reaction volume

Observation

Possible cause

Recommended action

Data collected on the

3730 instrument with POP-7"™
polymer: the D25441 and
D1S1656 markers in some
allelic ladder samples fail base-
pair spacing quality assessment

Data was analyzed using the
Light setting for Smoothing.

Use the None setting for Smoothing after
performing appropriate validation studies.

For more information, see the GeneMapper™
ID-X Software v1.4 New Features
and Installation Procedures User Bulletin

(Pub. No. 4477684), “Known issues: 3730 DNA

Analyzer sizing failures”.
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Required materials not supplied

Unless otherwise indicated, all materials are available through thermofisher.com. "MLS" indicates
that the material is available from fisherscientific.com or another major laboratory supplier. Catalog
numbers that appear as links open the web pages for those products.

STR kit

Item Source
VeriFiler" Express PCR Amplification Kit, 200-reaction kit A32014
GeneScan™ 600 LIZ" Size Standard v2.0, 2 x 200 uL 4408399

IMPORTANT! Do not use GeneScan™ 350 ROX", GeneScan™ 500 ROX",
or GeneScan" 500 LIZ™ Size Standards with this kit.

Hi-Di"™ Formamide, 25-mL 4311320

Sample preparation required materials

Treated paper substrate

Item Source

Collection system: NUCLEIC-CARD" system or Whatman FTA™

NUCLEIC-CARD™ Sample Collection Device A32607
NUCLEIC-CARD"™ matrix, 1 spot 4474001
NUCLEIC-CARD™ COLOR matrix, 1 spot 4473974
Whatman™ FTA™ Classic Cards MLS
Whatman™ EasiCollect™ system MLS

Sample preparation:

Prep-n-Go" Buffer (for use with untreated paper substrates) 4467079

Low-TE buffer (10 mM Tris, 0.1 mM EDTA, pH 8.0) Teknova T0223
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Appendix B Required materials not supplied

Sample preparation required materials

(continued)
Item Source
Punch tool:
Harris Micro-Punch™ tool, 1.2-mm MLS

BSD600-Duet Semi-Automated Dried Sample Punch Instrument with a
1.2-mm punch head

BSD1000-GenePunch Automated Dried Sample Punch Instrument with a
1.2-mm punch head

Contact your local sales office.

Untreated paper substrate

Item

Source

Collection system: Bode or paper

Buccal DNA Collector™ Device

Contact Bode Cellmark Forensics

903 paper MLS
Punch tool:
Harris Micro-Punch™ tool, 1.2-mm MLS

BSD600-Duet Semi-Automated Dried Sample Punch Instrument with a
1.2-mm punch head

BSD1000-GenePunch Automated Dried Sample Punch Instrument with a
1.2-mm punch head

Contact your local sales office.

Swab substrate

Item Source

Collection system: 4AN6FLOQSwabs™ reference collection devices
4NBFLOQSwabs™ Lollipop Swab in peelpouch 4473997
ANBFLOQSwabs™, Regular size tip in peelpouch 4473979
ANBFLOQSwabs™, Regular size tip in plain tube 44794331
4NB6FLOQSwabs™, Regular size tip in plastic tube with Active Drying System 4479439M]
ANB6FLOQSwabs *, Regular size tip plus 2-mL Eppendorf " cuvette in 447943101
peelpouch
ANBFLOQSwabs"™, Regular size tip plus 2-mL Eppendorf™ cuvette with ]

- , 44794400
evaporation duct in peelpouch
4ANB6FLOQSwabs™ Dual Swab Regular size tip in plain tube 4479432[1
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Appendix B Required materials not supplied
Thermal cycler required materials

(continued)
Item Source
4Sl)\/136t|;;OQSwabsw, Buccal shape tip in plastic tube with Active Drying 447943611
Cotton swabs MLS
Sample preparation
Prep-n-Go™ Buffer (for use with buccal swab substrates) 4471406
Heated lysis protocol only: 1.5 mL tube format or 96-well deep-well plate format
1.5 mL tube format
1.5 mL tubes MLS
Oven VWR"™ Scientifig dry heat block or
equivalent
96-well deep-well plate format
PrepFiler” 96-Well Processing Plates A47010
Robbins Scientific™ Model 400 Hybridization Incubator or equivalent MLS

Agilent™ Benchtop Rack for 200 L Tubes/V Bottom Plates (metal) or
equivalent

IMPORTANT! Do not use a plastic plate adaptor.

Agilent Technologies 410094

' To order, contact your local Thermo Fisher Scientific sales representative.

Thermal cycler required materials

ProFlex” PCR System

Iltem Source
ProFlex™ 96-well PCR System 4484075
ProFlex™ 2 x 96-well PCR System 4484076
ProFlex™ 3 x 32-Well PCR System 4484073
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GeneAmp" PCR System 9700

Appendix B Required materials not supplied

Genetic analyzer required materials

Item Source
GeneAmp™ PCR System 9700, 96-Well Silver N8050001
GeneAmp™ PCR System 9700, 96-Well Gold-Plated 4314878
Silver 96-Well Sample Block N8050251
Gold-Plated 96-Well Block 4314443
Genetic analyzer required materials
SeqStudio™ Genetic Analyzer

ltem Source

SeqStudio™ Data Collection Software v1.2.1 A46168
SeqStudio™ Genetic Analyzer Cartridge v2 A41331
SeqStudio™ Genetic Analyzer Cathode Buffer Container A33401
Reservoir Septa (for SeqStudio” Cathode Buffer Container) A35640
SeqStudio™ Integrated Capillary Protector A31923
MicroAmp™ Optical 96-Well Reaction Plate 4316813
MicroAmp"™ Optical 96-Well Reaction Plate with Barcode 4326659
MicroAmp"™ Optical 8-Tube Strip, 0.2 mL 4316567
Septa for SeqStudio™ Genetic Analyzer, 96 well A36541
Septa for SeqStudio™ Genetic Analyzer, 8 strip A36543
DS-36 Matrix Standard Kit (Dye Set J6) 4425042
3500 Series Genetic Analyzer

ltem Source
3500 Series HID Data Collection Software v4.0.1 A46085

3500 Series Data Collection Software 3.1

440518701, A26287

3500 Series Data Collection Software 3 4405186
3500 Series Data Collection Software 2 4475183
HID Updater 3500 Data Collection Software v2 4480670
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Appendix B Required materials not supplied
Genetic analyzer required materials

(continued)
Iltem Source
Anode buffer container (ABC) 4393927
Cathode buffer container (CBC) 4408256
POP-4" Polymer (960 samples) for 3500/3500xL Genetic Analyzers 4393710
POP-4" Polymer (384 samples) for 3500/3500xL Genetic Analyzers 4393715
DS-36 Matrix Standard Kit (Dye Set J6) 4425042
Conditioning reagent 4393718
8-Capillary array, 36 cm for 3500 Genetic Analyzers 4404683
24-Capillary array, 36 cm for 3500xL Genetic Analyzers 4404687
96-well retainer & base set (Standard) 3500/3500xL Genetic Analyzers 4410228
8-Tube retainer & base set (Standard) for 3500/3500xL Genetic Analyzers 4410231
8-Strip Septa for 3500/3500xL Genetic Analyzers 4410701
96-Well Septa for 3500/3500xL Genetic Analyzers 4412614
Septa Cathode Buffer Container, 3500 series 4410715
' Contact your Thermo Fisher Scientific HID representative.
3130 Series Genetic Analyzer
Item Source
3130 Data Collection Software v4 4475105
3130x/ Data Collection Software-v4 4475126
3130/3730 Data Collection Software-v4 6-Dye Module v1 4480670
96-Well Plate Septa 4315933
Reservoir Septa 4315932
3100/3130 x/ Genetic Analyzer Capillary Array, 36-cm 4315931
POP-4" Polymer for 3130/3130 x/ Genetic Analyzers 4352755
Running Buffer, 10X 402824
DS-36 Matrix Standard Kit (Dye Set J6) 4425042
MicroAmp™ Optical 96-Well Reaction Plate N8010560
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3730 Series Genetic Analyzer

Appendix B Required materials not supplied
Analysis software required materials

Item Source
3730xI Data Collection Software 5 4475133
3730/3730 x/ Data Collection Software-v4 4475154
3130/3730 Data Collection Software v4 6-Dye Module v1 4480670
96-Well Plate Septa 4315933
Reservoir Septa 4315932
3730 DNA Analyzer 48-Capillary Array, 36-cm 4331247
POP-7" Polymer for 3730/3730x/ DNA Analyzers 4335611
Running Buffer, 10X 4335613
DS-36 Matrix Standard Kit (Dye Set J6) 4425042
MicroAmp™ Optical 96-Well Reaction Plate N8010560
250-pL Glass Syringe (array-fill syringe) 4304470
5.0-mL Glass Syringe (polymer-reserve syringe) 628-3731
Analysis software required materials
GeneMapper™ ID-X Software

Item Source
GeneMapper" ID-X Software v1.6 Full Installation A39975
GeneMapper" ID-X Software v1.6 Client Installation A39976
GeneMapper" ID-X Software v1.5 Full Installation A27884
GeneMapper" ID-X Software v1.5 Client Installation A27886
GeneMapper" ID-X Software v1.4 Full Installation 4479707
GeneMapper" ID-X Software v1.4 Client Installation 4479711
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Miscellaneous required materials

Miscellaneous required materials

Plates and tubes

Item Source
MicroAmp™ 96-Well Tray N8010541
MicroAmp™ Reaction Tube with Cap, 0.2 mL N8010540
MicroAmp"™ 8-Tube Strip, 0.2 mL N8010580
MicroAmp"™ Optical 8-Cap Strips 4323032
MicroAmp™ 96-Well Tray/Retainer Set 403081
MicroAmp™ 96-Well Base N8010531
MicroAmp™ Clear Adhesive Film 4306311
MicroAmp™ Optical Adhesive Film 4311971
MicroAmp™ Optical 96-Well Reaction Plate N8010560
Laboratory supplies

Item Source
Various procedures
Aerosol resistant pipette tips MLS!]
Microcentrifuge tubes MLS
Pipettors MLS
Tape, labeling MLS
Tube, 50-mL Falcon™ MLS
Tube decapper, autoclavable MLS
Deionized water, PCR grade MLS
Vortex MLS

' Major laboratory supplier
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Example PCR plate layout

Example electrophoresis plate layout

Example PCR plate layout

The following layout is recommended for use with the sensitivity experiment in the Perform PCR
chapter. Create 3 identical plates for amplification at 4 different cycle numbers.

Plate layouts

1 2 3 5 6 7 8 9 10 11 12
Sample | Sample | Sample
a [ 1 [ 8 [ 1
Sample | Sample | Sample
8 [ 2 [ 9 16
Sample | Sample | Sample
c [ 3 [ 1w [ 17
Sample | Sample | Sample
D [ a 1 18
Sample | Sample | Sample
E [ s 12 [ 19
Sample | Sample Neg
F [ s 13 | Control
Sample | Sample 007
s [ 7 14
H
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Appendix C Plate layouts
Example electrophoresis plate layout

Example electrophoresis plate layout

The following layout is recommended for use with the sensitivity experiment in the Perform PCR

chapter.

1 2 3 4 5 3] 7 8 9 10 11 12
Sample | Sample | Sample | Sample | Sample | Sample | Sample | Sample | Sample | Sample | Sample | Sample
a [ 1 [ 8 [ 15 [ 12 [ 8 [ 15 [ 1 [ 8 [ 15 [ 1 [ 8 [ 15
Sample | Sample | Sample | Sample | Sample | Sample | Sample | Sample | Sample | Sample | Sample | Sample
B [ 2 [ s [ 16 [ 2 [ 9 [ 16 [ 2 [ 9 [ 16 [ 2 [ o [ 1
Sample | Sample | Sample | Sample | Sample | Sample | Sample | Sample | Sample | Sample | Sample | Sample
c [ 3 [ 1w [ 1w [ 3 [ w [ 1w [ 3 [ 1w [ 17w [ 3 [ o [ 17
Sample | Sample | Sample | Sample | Sample | Sample | Sample | Sample | Sample | Sample | Sample | Sample
o [ a [ mn [ 18 [ a [ 11 [ 18 [ a [ 11 [ 18 [ a [ 1n [ 1
Sample | Sample | Sample | Sample | Sample | Sample | Sample | Sample | Sample | Sample | Sample | Sample
e [ 5 [ 22 [ 19 [ 5 [ 12 [ 139 [ 5 [ 12 [ 19 [ 5 [ 12 [ 19
Sample | Sample Neg Sample | Sample Neg Sample | Sample Neg Sample | Sample Neg
£ [ 6 [ 13 |control[ 6 [ 13 |control/ 6 [ 13 |contral[ 6 [ 13 | control
Sample | Sample 007 Sample | Sample 007 Sample | Sample 007 Sample | Sample 007

c [ 7 [ 1a [ 7 [ 1a 7 [ 1a [ 7 [ 1
Allelic CE CE Allelic CE CE Allelic CE CE Allelic CE CE
H Ladder Blank Blank Ladder Blank Blank Ladder Blank Blank Ladder Blank Blank

Cycle 1 Cycle 2 Cycle 3 Cycle 4
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Work area setup and lab design . . ... oo e 131
PCR setup work areamaterials .. ...... ... i e 131
Amplified DNA WOrK area . ... ... e e e e e e 132

Work area setup and lab design

Many resources are available for the appropriate design of a PCR laboratory. If you are using this kit for:

* Forensic DNA testing, see "Forensic Laboratories: Handbook for Facility Planning, Design,
Construction, and Moving", National Institute of Justice, 1998

* Parentage DNA testing, see the "Guidance for Standards for Parentage Relationship Testing
Laboratories", American Association of Blood Banks, 7th edition, 2004

The sensitivity of this kit (and other PCR-based tests) enables amplification of minute quantities of DNA,
necessitating precautions to avoid contamination of samples yet to be amplified (Kwok and Higuchi,
1989).

Process samples carefully to prevent contamination by human DNA. Wear gloves at all times and
change them frequently. Close sample tubes when not in use. Limit aerosol dispersal by handling
sample tubes and reagents carefully.

Note: We do not intend these references for laboratory design to constitute all precautions and care
necessary for using PCR technology.

PCR setup work area materials

IMPORTANT! Do not remove these items from the PCR Setup Work Area.

¢ Calculator

* Gloves, disposable

* Marker pen, permanent
* Microcentrifuge

* Microcentrifuge tubes, 1.5-mL, or 2.0-mL, or other appropriate nuclease-free tube (for master mix
preparation)

* Microcentrifuge tube rack
* Pipette tips, sterile, disposable hydrophobic filter-plugged
* Pipettors
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Appendix D PCR work areas
Amplified DNA work area

* Tube decapper, autoclavable
* \ortex

Amplified DNA work area

IMPORTANT! Place the thermal cyclers in the Amplified DNA Work Area.

Use only the validated thermal cyclers listed in “Instrument and software compatibility” on page 15.
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Chemical safety . ... 134
Biological hazard safety . .......... o 135

WARNING! GENERAL SAFETY. Using this product in a manner not specified in the user
documentation may result in personal injury or damage to the instrument or device. Ensure that
anyone using this product has received instructions in general safety practices for laboratories and
the safety information provided in this document.

. Before using an instrument or device, read and understand the safety information provided in the
user documentation provided by the manufacturer of the instrument or device.

. Before handling chemicals, read and understand all applicable Safety Data Sheets (SDSs) and use
appropriate personal protective equipment (gloves, gowns, eye protection, and so on). To obtain
SDSs, see the “Documentation and Support” section in this document.
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Appendix E Safety
Chemical safety

Chemical safety

/W\. WARNING! GENERAL CHEMICAL HANDLING. To minimize hazards, ensure laboratory personnel
&~ read and practice the general safety guidelines for chemical usage, storage, and waste provided
below. Consult the relevant SDS for specific precautions and instructions:

. Read and understand the Safety Data Sheets (SDSs) provided by the chemical manufacturer
before you store, handle, or work with any chemicals or hazardous materials. To obtain SDSs, see
the "Documentation and Support" section in this document.

. Minimize contact with chemicals. Wear appropriate personal protective equipment when handling
chemicals (for example, safety glasses, gloves, or protective clothing).

. Minimize the inhalation of chemicals. Do not leave chemical containers open. Use only with
sufficient ventilation (for example, fume hood).

. Check regularly for chemical leaks or spills. If a leak or spill occurs, follow the manufacturer
cleanup procedures as recommended in the SDS.

. Handle chemical wastes in a fume hood.

. Ensure use of primary and secondary waste containers. (A primary waste container holds the
immediate waste. A secondary container contains spills or leaks from the primary container.
Both containers must be compatible with the waste material and meet federal, state, and local
requirements for container storage.)

. After emptying a waste container, seal it with the cap provided.

. Characterize (by analysis if needed) the waste generated by the particular applications, reagents,
and substrates used in your laboratory.

. Ensure that the waste is stored, transferred, transported, and disposed of according to all local,
state/provincial, and/or national regulations.

. IMPORTANT! Radioactive or biohazardous materials may require special handling, and disposal
limitations may apply.

WARNING! HAZARDOUS WASTE (from instruments). Waste produced by the instrument is
potentially hazardous. Follow the guidelines noted in the preceding General Chemical Handling
warning.

WARNING! 4L Reagent and Waste Bottle Safety. Four-liter reagent and waste bottles can crack
and leak. Each 4-liter bottle should be secured in a low-density polyethylene safety container with the
cover fastened and the handles locked in the upright position.
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Biological hazard safety

WARNING! Potential Biohazard. Depending on the samples used on this instrument, the surface
may be considered a biohazard. Use appropriate decontamination methods when working with
biohazards.

WARNING! BIOHAZARD. Biological samples such as tissues, body fluids, infectious agents,

and blood of humans and other animals have the potential to transmit infectious diseases.

Conduct all work in properly equipped facilities with the appropriate safety equipment (for example,
physical containment devices). Safety equipment can also include items for personal protection,

such as gloves, coats, gowns, shoe covers, boots, respirators, face shields, safety glasses, or
goggles. Individuals should be trained according to applicable regulatory and company/ institution
requirements before working with potentially biohazardous materials. Follow all applicable local,
state/provincial, and/or national regulations. The following references provide general guidelines when
handling biological samples in laboratory environment.

. U.S. Department of Health and Human Services, Biosafety in Microbiological and Biomedical
Laboratories (BMBL), 5th Edition, HHS Publication No. (CDC) 21-1112, Revised December 2009;
found at:
https://www.cdc.gov/labs/pdf/CDC-BiosafetymicrobiologicalBiomedicalLaboratories-2009-
P.pdf

. World Health Organization, Laboratory Biosafety Manual, 3rd Edition,
WHO/CDS/CSR/LYO/2004.11; found at:

www.who.int/csr/resources/publications/biosafety/Biosafety7.pdf
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Related documentation
Document title Pub. No.
STR kits
VeriFiler™ Express Kit - PCR and CE Quick Reference 100043592
VeriFiler™ Express Kit - PCR Setup — Swab Substrate Quick Reference 100043591
VeriFiler™ Express Kit — PCR Setup — Treated Paper Substrate Quick Reference 100043589
VeriFiler™ Express Kit - PCR Setup — Untreated Paper Substrate Quick Reference 100043590
Thermal cyclers
ProFlex™ PCR System User Guide MANO0007697
GeneAmp" PCR System 9700 Base Module User Manual 4303481
SeqStudio™ Genetic Analyzer
SeqStudio™ Genetic Analyzer Instrument and Software User Guide MANOO018646
SeqStudio™ Genetic Analyzer for HID Instrument and Software v1.2.1 User Bulletin—New 100086084
Features and Developmental Validation
3500 Series Genetic Analyzer
3500/3500xL Genetic Analyzer with 3500 Series Data Collection Software v1 User Guide 4401661
3500/3500xL Genetic Analyzer with 3500 Series Data Collection Software v2 User Guide 4476988
HID Updater 3500 Data Collection Software v2.0 User Bulletin NA
3500/3500xL Genetic Analyzer with 3500 Series Data Collection Software 3 User Guide 100025036
3500 Series Data Collection Software v3 User Bulletin: New Features and HID Validation MANO0010812
Summary
3500 Series Data Collection Software v3.1 User Bulletin: New Features and HID Validation MANO0014110

Summary
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Related documentation

(continued)
Document title Pub. No.
3500 Series Data Collection Software 4 User Bulletin: New Features and Developmental 100075298
Validation
3130 Series Genetic Analyzer
3130/3130xI Genetic Analyzers Maintenance, Troubleshooting, and Reference Guide 4352716
3130/3130xI Genetic Analyzers Using Data Collection Software v3.0 User Bulletin 4363787
3130/3130xI Genetic Analyzers Getting Started Guide 4352715
3130/3130xI Genetic Analyzers Quick Reference Card 4362825
3130/3130xI Genetic Analyzers AB Navigator Software Administrator Guide 4359472
3730 Series Genetic Analyzer
3730/3730xI Genetic Analyzer Getting Started Guide 4359476
3730xI Data Collection Software 5 for HID User Bulletin: New Features and Developmental MANO0019461
Validation
3730xI DNA Analyzer with 3730xI Data Collection Software 5 User Guide 100077621
GeneMapper" ID-X Software v1.3
GeneMapper™ ID-X Software v1.3 Verification Experiments and Installation Procedures User 4470483
Bulletin
GeneMapper" ID-X Software v1.4
GeneMapper™ ID-X Software v1.4 New Features and Installation Procedures User Bulletin 4477684
GeneMapper" ID-X Software v1.5
GeneMapper™ ID-X Software v1.5 New Features and Verification User Bulletin 100031708
GeneMapper™ ID-X Software v1.5 Getting Started Guide— Basic Features 100031701
GeneMapper™ ID-X Software v1.5 Quick Reference— Basic Features 100031702
GeneMapper™ ID-X Software v1.5 Getting Started Guide— Mixture Analysis Tool 100031704
GeneMapper™ ID-X Software v1.5 Quick Reference— Mixture Analysis Tool 100031705
GeneMapper™ ID-X Software v1.5 Installation Guide 100031706
GeneMapper™ ID-X Software v1.5 Administrator Guide 100031703
GeneMapper™ ID-X Software v1.5 Reference Guide 100031707
GeneMapper" ID-X Software v1.6
GeneMapper™ ID-X Software v1.6 New Features and Software Verification User Bulletin 100073905
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Customer and technical support

For support:

* In North America—Send an email to HIDTechSupport@thermofisher.com, or call
888-821-4443 option 1.

* Outside North America— Contact your local support office.

For the latest services and support information for all locations, go to thermofisher.com/support to
obtain the following information.

Worldwide contact telephone numbers

* Product support

® Order and web support

* Safety Data Sheets (SDSs; also known as MSDSs)

Additional product documentation, including user guides and Certificates of Analysis, are available by
contacting Customer Support.

Limited product warranty

Life Technologies Corporation and/or its affiliate(s) warrant their products as set forth in the

Life Technologies' General Terms and Conditions of Sale at www.thermofisher.com/us/en/home/
global/terms-and-conditions.html. If you have any questions, please contact Life Technologies at
www.thermofisher.com/support.
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